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Release Notes
Welcome to the June 2013 release of IBM® TRIRIGA® 10.3.1 and IBM TRIRIGA Application Platform
3.3.1. This release includes a full installation of the platform and applications and a platform-only
upgrade installation from 2.5.x or higher to IBM TRIRIGA Application Platform 3.3.1.
IBM TRIRIGA delivers application object migration packages using two different methodologies:
incremental packages and cumulative packages. See IBM TRIRIGA Application Object Migration
Packages for more information.


Incremental Package – Each application release is a separate file. The latest incremental
package is for IBM TRIRIGA 10.3.1.



Cumulative Package – The entire suite of IBM TRIRIGA applications through IBM TRIRIGA 10.1 is
in one file. Cumulative packages offer a substantial time savings for customers upgrading across
several releases. The latest cumulative package is for IBM TRIRIGA 10.1.

These release notes include the following:


An overview of enhancements and changes



A list of known limitations



A list of documentation changes in this release

Many of the descriptions include an internal reference number (Tri-nnnnn).



Note – To request access to IBM TRIRIGA software releases prior to IBM TRIRIGA 10.2 or
IBM TRIRIGA Application Platform 3.2, submit a ticket through the IBM Software Support
site at www.ibm.com/support.

What’s New in This Release
With IBM TRIRIGA 10.3.1 and IBM TRIRIGA Application Platform 3.3.1, IBM TRIRIGA continues to add
valuable functionality, fix defects, and reduce the effort necessary for new and existing customers to
implement our products. Highlights in IBM TRIRIGA 10.3.1 and IBM TRIRIGA Application Platform 3.3.1
include the following:

IBM TRIRIGA 10.3.1 Enhancements
The enhancements to IBM TRIRIGA for this release include the following:
Area of Impact

Description

Workplace
Reservation Manager

You can perform workspace searches based on the functional role
entitlements that are configured on the workspace for the user that is
identified as the requested for. This feature is enabled and disabled in the
Application Settings. (Tri-70097)

Asset Lease

The FASB 13 Treatment section is now available for asset leases. You use this
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Area of Impact

Description
section to identify whether an asset lease is treated as an operating lease or
as a capital lease. (Tri-80665)

Real Property
Information Model

IBM TRIRIGA has been enhanced to support the requirements of the US
Department of Defense Real Property Information Model (RPIM) initiative.
Additions include changes to the data model, classifications, and business
rules to support the data elements and reporting required by RPIM.

Workplace
Reservation Manager



A notification now informs the requester of a reservation when the room
was set up for auto-cancellation and the system canceled the room.
(Tri-75224)



New reports for equipment reservations and vehicle reservations show
the reservation along with the assets that were reserved. Additional
reports show reservations for the next 30 days and reservations in the
past. (Tri-68882, Tri-68893, Tri-68971)



New usability features include creating reservations in the past and
closing an ongoing meeting early. (Tri-68980, Tri-70252)

IBM TRIRIGA Application Platform 3.3.1 Enhancements
The enhancements to the IBM TRIRIGA Application Platform for this release include the following:
Area of Impact

Description

Accessibility

Users accessing IBM TRIRIGA with an accessibility tool like a screen reader
can now read field labels and attributes and the alternate text for images.

Browser Support

Users can now use IBM TRIRIGA from the following browsers:


Apple Safari



Google Chrome



Microsoft Internet Explorer



Mozilla Firefox

For detailed information about support for each browser, see the Important
Information and Known Limitations for IBM TRIRIGA Application Platform.
For detailed information about supported browser versions and supported
operating systems for each browser, see the IBM TRIRIGA Application
Platform Compatibility Matrix.
Globalization

In addition to Brazilian Portuguese, Czech, Dutch, French, German,
Hungarian, Italian, Japanese, Norwegian, Polish, Russian, Simplified Chinese,
Spanish, Swedish, US English, and Traditional Chinese, IBM TRIRIGA
applications now have language packs available in British English, Danish,
Finnish, and Korean.
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Area of Impact

Description

Help

Help now opens the help record for a business object when invoked from a
manager query context. (Tri-88917)

IBM TRIRIGA
Connector for
Business Applications

The IBM TRIRIGA Connector for Business Applications now supports methods
for metric queries.

IBM TRIRIGA
Connector for ESRI
Geographic
Information System
(GIS)

The enhanced Esri viewer offers redesigned configuration forms, flexibility in
creating customized interfaces with Esri, and an upgrade path from the
previous version.

Red Hat JBoss

Red Hat JBoss 5.1 Enterprise Application Platform (EAP) application server is
now supported.

TRIRIGA Integration
Object

Expanded support for REST API with the following new features:

User's Session



Tokens to use dynamic data from queries to send data



Request types for delete, get, post, and put operations



Headers



Validation of data before it is sent

A user with a session that is about to timeout can receive an alert message
that gives them notice of when the session is to expire. A system
administrator configures this feature from the TRIRIGAWEB.properties. The
SESSION_WARNING_ENABLED property can be configured to trigger the alert.
The SESSION_WARNING_THRESHOLD property defines how many minutes
before the session expires that the alert displays. (Tri-71462, Tri-81074IV38021)

IBM TRIRIGA CAD Integrator/Publisher 12.0.1 Enhancements
The enhancements to the IBM TRIRIGA CAD Integrator/Publisher for this release include the following:
Area of Impact

Description

Attach

Attach now updates only the fills and labels for the record that is being
attached.

Batch Associate

Batch Associate dialog has an improved layout.

Batch Process

Batch Process form allows the user to add or remove multiple drawings at
once.

Bentley MicroStation



Edit Record command stays active so the user can open multiple records
in a single command.
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Area of Impact

Description


Insert Object and Attach Object commands stay active so the user can
insert or attach multiple records in a single command.



Apply Theme, Apply Label, and Apply Report forms stay open so the user
can apply different reports in succession.



Smart Attach Design File supports selecting a level.



Batch Associate and Batch Edit support preselecting entities.

Detach Object

Detach Object command now stays active so the user can detach multiple
records in a single command.

Insert Object

Insert Object now updates only the fills and labels for the record that is
being attached.

Report

Report list now shows the Graphic reports that are defined as My Reports.

Smart Attach

Smart Attach now displays messages that indicate the progress of the records
that are being uploaded, for example, "Uploaded 40 of 194 records...".

Smart Attach

Smart Attach now provides the ability to "Select from Drawing" from a button
on the Smart Attach dialog instead of from a drop-down list for each layer.

Smart Attach

Smart Attach now remembers the last layer that the user selected for each
layer option.

Important Installation and Upgrade Information
Go to the IBM TRIRIGA Application Platform 3 Information Center and read Installing IBM TRIRIGA
Application Platform before installing. Also read the IBM TRIRIGA Application Platform 3 Upgrade
Installation Guide, which can be found at
https://www.ibm.com/developerworks/community/wikis/home?lang=en#/wiki/IBM+TRIRIGA1/page/Up
grading. Note the following in particular:


All upgrades should be staged in a test environment and thoroughly reviewed before upgrading
any production environment.



Perform a database backup before upgrading any environment.



The user that performs an installation must have write or create access to the installation root
directory.



When you perform a platform upgrade, make sure there are no application servers running or
other active connections to the database. If there are connections to the database other than
the installer, the installer may fail.



After platform new install or upgrade and before starting the application server, make sure
your licenses are in the \config\licenses folder. All product licenses you own must be in
the \config\licenses folder. All application servers that point to your database must have
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the same license set. For information about the two types of IBM TRIRIGA license files, go to
the IBM TRIRIGA Application Platform 3 Information Center and select Installing IBM TRIRIGA
Application Platform > Configuring the platform > License files. If you are on WebSphere,
verify that valid resource URLs exist for all licenses before starting the application server. For
more information, go to the IBM TRIRIGA Application Platform 3 Information Center and select
Installing IBM TRIRIGA Application Platform.


After you perform a platform upgrade, only start one application server. Do not bring up any
other application servers until the upgrade to the first one is complete. Often upgrades are
completed during the initial startup of an application server and there may be conflicts if two
application servers are started in parallel.



Note – If your database was created from a version of IBM TRIRIGA Application Platform
prior to 3.1, you can use scripts that IBM TRIRIGA provides to remove unused columns from
the IBS_SPEC and IBS_SPEC_ASSIGNMENTS tables in the IBM TRIRIGA database. These
tables are the two largest and most used tables in the IBM TRIRIGA system. Removing
unused columns from these tables can improve performance and reduce storage space
requirements. An IBM TRIRIGA system functions properly without applying this upgrade. The
IBM TRIRIGA Application Platform 3.1 Post Upgrade Maintenance Specification outlines the
steps and contains scripts to be copied and used to remove the unused columns.

The following sections outline the upgrade steps for a selection of upgrade scenarios. In addition to the
above, perform the steps appropriate for your company’s upgrade scenarios and according to your
company’s upgrade practices. These steps are not intended to substitute for your company’s testing
and validation procedures.


Upgrade from IBM TRIRIGA 10.x/IBM TRIRIGA Application Platform 3.x  10.3.1/3.3.1



Upgrade from IBM TRIRIGA 10.x/IBM TRIRIGA Application Platform 3.x  3.3.1 (platform only)



Upgrade from TRIRIGA 9/prior to TRIRIGA Application Platform 3.0  10.3.1/3.3.1



Upgrade from prior to TRIRIGA 10.0/TRIRIGA Application Platform 3.0  3.3.1 (platform only)

Upgrade from IBM TRIRIGA 10.x/IBM TRIRIGA Application Platform
3.x  10.3.1/3.3.1
If you are upgrading from IBM TRIRIGA 10.x and IBM TRIRIGA Application Platform 3.x, it is critical to
complete the upgrade to IBM TRIRIGA 10.3.1 and IBM TRIRIGA Application Platform 3.3.1 in the
following sequence. Perform the following steps in addition to the above and to your company’s
upgrade practices. These steps are not intended to substitute for your company’s testing and validation
procedures.
Only follow this sequence when upgrading to IBM TRIRIGA 10.3.1 and IBM TRIRIGA Application Platform
3.3.1 from IBM TRIRIGA 10.x and IBM TRIRIGA Application Platform 3.x:
Additional Steps for Installations Upgrading from IBM TRIRIGA 10.x and IBM TRIRIGA
Application Platform 3.x  10.3.1 and 3.3.1
Step 1

Upgrade the platform to IBM TRIRIGA Application Platform 3.3.1. The instructions are
in the IBM TRIRIGA Application Platform 3 Upgrade Installation Guide, which can be
found at
https://www.ibm.com/developerworks/community/wikis/home?lang=en#/wiki/IBM+T
RIRIGA1/page/Upgrading.
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Additional Steps for Installations Upgrading from IBM TRIRIGA 10.x and IBM TRIRIGA
Application Platform 3.x  10.3.1 and 3.3.1
Step 2

Start the server and allow the server startup processes to run.

Step 3

If your system is on TRIRIGA 10.0, perform the steps required to upgrade to the
TRIRIGA 10.1 application.

Step 4

Restart the application server.

Step 5

If your system is on TRIRIGA 10.1, perform the steps required to upgrade to the IBM
TRIRIGA 10.2.0.2 application.

Step 6

Restart the application server.

Step 7

Apply the SQL script to update the system fields with sub-attribute type of
CreatedDateTime to CreatedDateTime (Number) and ModifiedDateTime to
ModifiedDateTime (Number). Scripts for Oracle and Microsoft SQL Server are
located on the upgrade disk in the \Scripts folder. Instructions are within the
scripts.
For Oracle, run SetVarcharColsToNumeric_ORCL.sql.
There are two scripts for MSSQL, SetVarcharColsToNumeric_MSSS.sql and
SetVarcharColsToNumeric_MSSS_Publish_BO.sql. Run
SetVarcharColsToNumeric_MSSS.sql first. When it completes, run
SetVarcharColsToNumeric_MSSS_Publish_BO.sql.

Step 8

Due to potential dependencies when localizing reference fields for instance data
globalization, all business objects must be republished. Scripts for Oracle and
Microsoft SQL Server are located on the upgrade disk in the \Scripts folder.
Instructions are within the scripts.
For Oracle, run Publish_all_BOs_For_localization_ORCL.sql.
For MSSQL, run Publish_all_BOs_For_localization_MSSS.sql.

Step 9

Perform the steps required to upgrade to the IBM TRIRIGA 10.3.1 application.

Upgrade from IBM TRIRIGA 10.x/IBM TRIRIGA Application Platform
3.x  3.3.1 (Platform Only)
If you are upgrading an IBM TRIRIGA 10.x environment, it is critical to complete the upgrade to IBM
TRIRIGA Application Platform 3.3.1 in the following sequence. Perform the following steps in addition
to the above and to your company’s upgrade practices. These steps are not intended to substitute for
your company’s testing and validation procedures.
Only follow this sequence when upgrading an IBM TRIRIGA 10.x environment to IBM TRIRIGA Application
Platform 3.3.1 from IBM TRIRIGA Application Platform 3.x:
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Additional Steps for Installations Upgrading an IBM TRIRIGA 10.x Environment Platform Only
from IBM TRIRIGA Application Platform 3.x  3.3.1
Step 1

Upgrade the platform to IBM TRIRIGA Application Platform 3.3.1. The instructions are
in the IBM TRIRIGA Application Platform 3 Upgrade Installation Guide, which can be
found at
https://www.ibm.com/developerworks/community/wikis/home?lang=en#/wiki/IBM+T
RIRIGA1/page/Upgrading.

Step 2

Start the server and allow the server startup processes to run.

Upgrade from TRIRIGA 9/Prior to TRIRIGA Application Platform 3.0 
10.3.1/3.3.1
If you are upgrading from TRIRIGA 9 and a platform release prior to TRIRIGA Application Platform 3.0,
it is critical to complete the upgrade to IBM TRIRIGA 10.3.1 and IBM TRIRIGA Application Platform 3.3.1
in the following sequence. Perform the following steps in addition to the above and to your company’s
upgrade practices. These steps are not intended to substitute for your company’s testing and validation
procedures.
Only follow this sequence when upgrading to IBM TRIRIGA 10.3.1 and IBM TRIRIGA Application Platform
3.3.1 from TRIRIGA 9 and a platform release prior to TRIRIGA Application Platform 3.0:
Additional Steps for Installations Upgrading from TRIRIGA 9 and a Platform Release Prior to
TRIRIGA Application Platform 3.0  10.3.1 and 3.3.1
Step 1

In order to upgrade your target system to IBM TRIRIGA Application Platform 3.3.1, the
target system must be on TRIRIGA Application Platform 2.5.0 or later. If it is on
2.1.9.x or earlier, you must first upgrade to 2.7.1.3. After the 2.7.1.3 install is
complete, start the application server to finish the upgrade. See the TRIRIGA Release
Notes for 9.7.1 and 2.7.1.3 for more information. Do not start the upgrade to 3.3.1
until the 2.7.1.3 application has fully started one time following upgrade.

Step 2

Shut down the application server.

Step 3

Upgrade the platform to IBM TRIRIGA Application Platform 3.3.1. The instructions are
in the IBM TRIRIGA Application Platform 3 Upgrade Installation Guide, which can be
found at
https://www.ibm.com/developerworks/community/wikis/home?lang=en#/wiki/IBM+T
RIRIGA1/page/Upgrading. Do not start the application server.

Step 4

Set the BYPASS_PORTAL_MENU_UPGRADE property in TRIRIGAWEB.properties to
Y, which will bypass the portal and menu upgrades that typically run with an upgrade
to IBM TRIRIGA Application Platform 3.3.1. Your system receives the portal and menu
upgrades when you import the TRIRIGA 10.1 cumulative object migration package
(which you will do in Step 7). Review and revise the other properties files as
appropriate for your implementation. For more information, go to the IBM TRIRIGA
Application Platform 3 Information Center and select Installing IBM TRIRIGA
Application Platform > Configuring the platform > Properties files.
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Additional Steps for Installations Upgrading from TRIRIGA 9 and a Platform Release Prior to
TRIRIGA Application Platform 3.0  10.3.1 and 3.3.1
Step 5

Start the server and allow the server startup processes to run.

Step 6

Starting with TRIRIGA 10.0, IBM TRIRIGA applications place standard actions, such as
Copy, Apply Template, and Delete, under a More action in the form. Upgrading
customers can apply this change to previous forms that were not updated or changed
by new functionality. To do this you must run a SQL script against your database. Run
this script AFTER the latest platform upgrade but BEFORE importing the TRIRIGA 10.1
object migration package. The SQL files are located in your install folder under
\userfiles\upgrades. Use either file STATE_ACTION_updates_oracle.sql or
file STATE_ACTION_updates_msssqlserver.sql. (Tri-29957)

Step 7

Perform the steps required to upgrade to the TRIRIGA 10.1 application.

Step 8

Restart the application server.

Step 9

Perform the steps required to upgrade to the IBM TRIRIGA 10.2.0.2 application.

Step 10 Apply the SQL script to update the system fields with sub-attribute type of
CreatedDateTime to CreatedDateTime (Number) and ModifiedDateTime to
ModifiedDateTime (Number). Scripts for Oracle and Microsoft SQL Server are
located on the upgrade disk in the \Scripts folder. Instructions are within the
scripts.
For Oracle, run SetVarcharColsToNumeric_ORCL.sql.
There are two scripts for MSSQL, SetVarcharColsToNumeric_MSSS.sql and
SetVarcharColsToNumeric_MSSS_Publish_BO.sql. Run
SetVarcharColsToNumeric_MSSS.sql first. When it completes, run
SetVarcharColsToNumeric_MSSS_Publish_BO.sql.
Step 11 Due to potential dependencies when localizing reference fields for instance data
globalization, all business objects must be republished. Scripts for Oracle and
Microsoft SQL Server are located on the upgrade disk in the \Scripts folder.
Instructions are within the scripts.
For Oracle, run Publish_all_BOs_For_localization_ORCL.sql.
For MSSQL, run Publish_all_BOs_For_localization_MSSS.sql.
Step 12 Perform the steps required to upgrade to the IBM TRIRIGA 10.3.1 application.

Upgrade from Prior to TRIRIGA 10.0/TRIRIGA Application Platform 3.0
 3.3.1 (Platform Only)
If you are upgrading from releases prior to TRIRIGA 10.0 and TRIRIGA Application Platform 3.0, it is
critical to complete the platform upgrade to IBM TRIRIGA Application Platform 3.3.1 in the following
sequence. Perform the following steps in addition to the above and to your company’s upgrade
practices. These steps are not intended to substitute for your company’s testing and validation
procedures.
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Only follow this sequence when upgrading a pre-TRIRIGA 10.0 environment to IBM TRIRIGA Application
Platform 3.3.1 from releases prior to TRIRIGA Application Platform 3.0:
Additional Steps for Installations Upgrading Platform Only from Releases Prior to TRIRIGA
Application Platform 3.0  3.3.1
Step 1

In order to upgrade your target system to IBM TRIRIGA Application Platform 3.3.1, the
target system must be on TRIRIGA Application Platform 2.5.0 or later. If it is on
2.1.9.x or earlier, you must first upgrade to 2.7.1.3. After the 2.7.1.3 install is
complete, start the application server to finish the upgrade. See the TRIRIGA Release
Notes for 9.7.1 and 2.7.1.3 for more information. Do not start the upgrade to 3.3.1
until the 2.7.1.3 application has fully started one time following upgrade.

Step 2

Shut down the application server.

Step 3

Upgrade the platform to IBM TRIRIGA Application Platform 3.3.1. The instructions are
in the IBM TRIRIGA Application Platform 3 Upgrade Installation Guide, which can be
found at
https://www.ibm.com/developerworks/community/wikis/home?lang=en#/wiki/IBM+T
RIRIGA1/page/Upgrading. Do not start the application server.

Step 4

Set the BYPASS_PORTAL_MENU_UPGRADE property in TRIRIGAWEB.properties to
N, which allows the portal and menu upgrades that typically run with an upgrade to
IBM TRIRIGA Application Platform 3.3.1. Review and revise the other properties files
as appropriate for your implementation. For more information, go to the IBM TRIRIGA
Application Platform 3 Information Center and select Installing IBM TRIRIGA
Application Platform> Configuring the platform > Properties files.

Step 5

Start the server and allow the server startup processes to run.

Step 6

TRIRIGA 9 customers need to import the object migration package that contains the
form and workflow changes for the new navigation and portals. This file is located in
the install directory under \userfiles\upgrades\Portal BO Upgrade.zip. See
the IBM TRIRIGA Application Platform 3 Object Migration User Guide for information
about importing object migration packages.

© Copyright IBM Corporation 2011, 2013.

9

IBM TRIRIGA 10.3.1
This chapter details important information, known limitations, and changes for IBM TRIRIGA.

Important Information
Important information concerning IBM TRIRIGA for this release includes the following:
Area of Impact

Description

Bulk Update
Processing of Leases

Users may experience extended processing times when using the Bulk Create
Review Assumptions Request across a large number of leases. To process
more efficiently, instead of selecting all of the leases at one time for bulk
update, select a few at a time. (Tri-36007)

Externally Generated
Lease Abstract
Records

The Lease ID of a Lease Abstract record should be unique.

Geography

The System Geography field on the System tab of the Asset Specification
form needs to be cleared in order for buildings to be displayed correctly for
location, equipment, and vehicle reservation types on the Room Reservation
form for the Contact Center. (Tri-87474)

Installation

Apply the SQL script to update the system fields with sub-attribute type of
CreatedDateTime to CreatedDateTime (Number) and
ModifiedDateTime to ModifiedDateTime (Number). Scripts for Oracle
and Microsoft SQL Server are located on the upgrade disk in the \Scripts
folder. Instructions are within the scripts.
For Oracle, run SetVarcharColsToNumeric_ORCL.sql.
There are two scripts for MSSQL, SetVarcharColsToNumeric_MSSS.sql
and SetVarcharColsToNumeric_MSSS_Publish_BO.sql. Run
SetVarcharColsToNumeric_MSSS.sql first. When it completes, run
SetVarcharColsToNumeric_MSSS_Publish_BO.sql.

Workplace
Reservation Manager

When you use the IBM TRIRIGA Reserve tab in Microsoft Outlook to make a
reservation, after you specify the reservation subject, either press Tab or
click outside the Subject field. (Tri-77073)
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Known Limitations
Known limitations concerning IBM TRIRIGA for this release include the following:
Area of Impact

Description

Gantt

If you create many tasks in the Gantt, then delete the tasks from the Gantt,
and then save the project record, some of the tasks may not be deleted. This
is because all of the asynchronous workflows that are triggered by these
activities did not have sufficient time to complete. If this occurs, delete the
tasks in the Gantt that should have been deleted. (Tri-38256)

Globalization

Attention messages for Classification records display in US English because
the record language for the delivered instance data (system data) is US
English. (Tri-39803)

Installer for the IBM
TRIRIGA Workplace
Reservation Manager
Add-In to Microsoft
Outlook

The installer is only available in US English. Installing to a path under
Program Files may not work on a non-English version of Windows.

Real Estate Lease
Payment Schedules



When the total is not evenly divisible by the frequency, rounding causes
the sum of the payment line items (PLI) to be greater than the total. For
example, if the frequency is semi-annual and the annual amount is
$1,000.47, two PLIs are created in the amount of $500.24. This value is
rounded up from $500.235. When you add up the PLIs, the total is
$1,000.48, which is one cent greater than the annual amount.



When the frequency is weekly or bi-weekly, the number of PLIs created
is based on the number of weeks in the calendar for that year. For
example, 2012 has 52 weeks and 2 days, which results in 53 PLIs, each
with a weekly payment based on 52 weeks. When you add up the PLIs for
that year, the amount is too large by one payment because of the 53rd
PLI representing the extra two days. The same result occurs when the
frequency is bi-weekly and there are more than 52 weeks in the calendar
for that year, because the calculation is based on 26 payments.



The values displayed in the Cost / Unit (Year) column and in the Cost per
Unit field have two decimal places; however, the values stored in the
database have six decimal places. The database value with six decimal
places is used to calculate the value of the Period Amount field and the
Annual Amount field. For example, the formula is Annual Amount = Cost
/ Unit (Year) * Contract Rentable. A manual calculation using the two
decimal precision displayed is $137.81 Cost / Unit (Year) * 20000
Contract Rentable = $2,756,200.00 Annual Amount. However, when the
six decimal precision stored in the database is used, the calculated
Annual Amount displayed is $2,756,250.00. This is a difference of $50.00.



The Charge Amount Basis values of per Area (Annually) and of per Area
(Monthly) do not apply to an asset lease. Because the Generate Payment
Schedule wizard is a standard form, it is possible for a user to select
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Area of Impact

Description
these values; however, the value of the Expected Cash Amount field on
the generated Payment Schedule form will be zero.

Reservation Survey
Requests

In a new Reservation Survey Request form, you must select the Create Draft
action before selecting either the Find Parameter Recipients action or the
Find Random Recipients action when the parameter fields are populated. In
an existing Reservation Survey Request form, when the parameter fields are
modified or populated, you must select the Save action before selecting
either the Find Parameter Recipients action or the Find Random Recipients
action. If you do not, neither action works as expected; the action does not
pick up the changes in the parameter fields. (Tri-36865)

Workplace
Reservation Manager

To add links from a building or a space to the reservation notification that is
created from IBM TRIRIGA, attach a document that contains the links.
(Tri-68968)

Workplace
Reservation Manager

When looking at a reservation from Microsoft Outlook Web Access (OWA), the
text on action buttons (such as check in, early notification) does not show
clearly in preview mode. To see the text more clearly, you can open the
appointment. (Tri-68953)

IBM TRIRIGA 10.3.1 Changes
Area of Change

Description

Application Settings

On a clean install, in Application Settings, the Lease Abstract Defaults fields
(Default Parent for Internal Organization, Default Parent for Location,
Default Parent for External Organization) and Date Generation field (Start
Date) are now blank. (Tri-88848)

Asset Lease

Multiple copies of the same Asset Lease are created on Activate when an
Includes Index Adjustment clause and a Payment Schedule are added. To
resolve this issue requires a change in the Index Adjust Calculator
(triIndexAdjustmentCalculator) business object. This change is not
included in the 10.3.1 release object migration package.
To resolve this issue, run the following SQL to update the smart section
attribute on the Index Adjust Calculator business object. You can run the
SQL either before or after importing the 10.3.1 release object migration
package into your environment. (Tri-73713)
SELECT *
FROM module_association
WHERE source_module = 16
AND source_bo_id = 10010440
AND association_verb='Has Contract'
AND ass_module = 21
AND ass_bo_id = 10008550
/* update Association Manager */
UPDATE module_association
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Description
SET dependent_flag =0, cascade_read_only=0
WHERE source_module =16
AND source_bo_id = 10010440
AND association_verb='Has Contract'
SELECT *
FROM dd_sobjtype_sections
WHERE spec_template_id = 10010440
AND category_id = 1
AND sub_category_name = 'triAssetLease'
/* updates Data Dictionary Smart Section table
dd_sobjtype_sections */
update dd_sobjtype_sections
set override_flag=0,
input_option=2,
live_link=1
WHERE spec_template_id = 10010440
AND category_id = 1
AND sub_category_name = 'triAssetLease'
SELECT *
FROM sobjtype_sections
WHERE spec_template_id = 10010440
AND category_id = 1
AND sub_category_name = 'triAssetLease'
AND ref_spec_template_id = 10008550
/* Update One more Smart Section table */
update sobjtype_sections
set override_flag=0,
live_link=1,
input_option=2
WHERE spec_template_id = 10010440
AND category_id = 1
AND sub_category_name = 'triAssetLease'
AND ref_spec_template_id = 10008550

Asset Lease

When an asset lease is revised, the history lease retains the information for
the FASB 13 section of the original lease. The history asset lease record does
not calculate a present value (PV) as only a payment schedule was created
and no payment line items (PLI) were generated. The PLIs are used for
calculating the straight line, which is used for PV of Rent/PV of rent building
only (discounted) values. (Tri-83342)

Asset Manager

The Spec Class field in the Spec Information section of all Asset forms has
been made read only.
The Spec Class field in the Core and Key Specification forms now displays its
own Specification Class hierarchy list instead of the ROOT Specification Class
hierarchy list. (Tri-88855- IV42741)

Blanket Purchase

When selecting the service organization contact lookup and the bill to
contact lookup for an external contact, consultant, or employee with an
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Area of Change

Description

Order

address greater than 50 characters, the blanket purchase order record no
longer hangs. The address field now accepts 200 characters. (Tri-75859IV36887)

CAD Integrator and
Space Records

The extended formula for the triHeadcountNU field on the triFloor,
triBuilding, and triProperty business objects now uses a query
instead of an associated business object field. (Tri-70761)

CAD Integrator and
Space Records

When creating new Space records from CAD Integrator, the update process
(Permanent Save validation workflow) is no longer executed twice. The
update process now runs asynchronously. (Tri-70759)

Capital Project
Template

Resolved an issue that caused security groups for Capital Project Template
forms to not work correctly when the USE_PROJECT_SECURITY property in
the TRIRIGAWEB.properties file was set to Y. You now can create a task
within a Capital Project Template. (Tri-74011-IV30868)

Capital Projects

The behavior of the All Capital Project query Delete action has changed. The
Delete now deletes the selected record in the query. (Tri-89423)

Change Person
Request

Update Personnel Information (Change Person Request) now maps all the
data under the Updated Personnel Details section on the Change Person
Request to the Person record. My Profile data is kept in sync if the Person
record is in Active User status. (Tri-82079-IV39415)

Classifications

Updated the business object label for triResponsibilityCategory to
Responsibility Category. Existing customers should run the following SQL
scripts in order to update the Business Object field in System tab of
Responsibility Category Classification records.
Update ibs_spec set updated_date=sysdate where spec_id in
(select spec_id from t_triResponsibilityCategory where
triBusinessObjectLabel = 'Area Type');
Update t_triResponsibilityCategory set
triBusinessObjectLabel='Responsibility Category',
triBusinessObjectLabel2='Responsibility Category' where
triBusinessObjectLabel = 'Area Type';
(Tri-70674)

Contact Center

On the Contact Center form, the Agent Name is now correctly populated
with the User that is logged in. Agent Name is populated through workflow
instead of using the Platform Auto Populate functionality. (Tri-78699)

Contact Center

The Requested For field on the Contact Center form is now populating the
correct Active User. The Organization is now mapped correctly from the
Requested For person to the Service Request that is created from the
Contact Center Request. (Tri-76653-IV37280)

Contact Roles

Test data has been removed from the list of system data for Contact Roles.
(Tri-88850)
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Description

Contracts > Leases

When a user clicks the Issue action in the Payment Reconciliation Action
item, the routing now proceeds to completion. (Tri-80223-IV38558)

Data Modeler

Increased the size of the FUNCTION_DESC field in the Formula business
object in the System module from 100 to 150. (Tri-91539)

Disposition Request

The queries for Related Reports now return records in the appropriate
statuses. (Tri-90374)

Equipment Orders
list page

When a reservation with equipment orders is deleted, the equipment orders
are now removed from the Equipment Orders pages. (Tri-86450)

Find Space

The Personnel Directory columns now display data from the People record
instead of from the My Profile record. (Tri-77005-IV37979)

Find Space

The Personnel Directory section now displays people records that have the
associated primary location set to the Space that is created under a Space
Group. (Tri-77004-IV37978)

Generate Payment
Schedule form

On the Generate Payment Schedule form in the Payment Parameters section,
the label is changed from “First Payment Amount” to “Amount Per Basis”.
(Tri-70800)

Generate Payment
Schedule form

The label “Monthly Amount” is now “Period Amount” on the Payment
Schedule section of the Generate Payment Schedule form. (Tri-70795)

Generate Payment
Schedule form and
Payment Schedule
form

1. When the Frequency is ‘Monthly’, and Charge Basis Amount is ‘per Area
(Monthly)’ or ‘per Area (Annually)’, the Cost per Unit field on a Payment
Schedule is now calculated correctly.
2. When the Frequency is something other than ‘Monthly’ and the value of
Charge Amount Basis field is not ‘per Month’, the calculations of Monthly
Amount, Annual Amount, and Cost / Unit (Year) in the Payment Schedule
section of the Generate Payment Schedule wizard are now correct.
(Tri-70442-IV34303)

Integration Object

When you import instance records for the TRIRIGA Integration Object, run
the patch helper named IntegrationObject_DataMaps. This patch
helper triggers a utility that scans the current datamaps and correctly
reassigns the object IDs that are needed to save records. (Tri-74041)

Inventory

The Services form now opens when the user navigates to Inventory > Setup >
Contracts > Services. Previously, the Services Specification form was
rendered. (Tri-71228-IV36022)

Lease Abstract

Tenant Rights (and child nodes), Landlord Rights (and child nodes), LL
Provision of Services to Premises, and Must Take Space have been removed
from Classification Hierarchy - Clause Type > Real Estate Lease Clause Type >
Other. They are no longer available for selection from the Other Clauses tab
of the Lease Abstract form. Instead they are available/added to
Classification Hierarchy - Clause Type > Real Estate Lease Clause Type >
Rights > Other Rights. And they are now available to add from the Rights tab
of the Lease Abstract form.
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Description
These same changes are also applied to Lease Abstract Template.
Note: These items on the Other Clauses Classification hierarchy have been
removed from the shipping product. But existing customers using above
listed items from the Other Clauses tab of Lease Abstract should update their
environments to use the items on the Rights tab instead and to remove the
records from the Other Clauses classification hierarchy manually. (Tri-81725IV38447)

Lease Abstract

The Responsibilities Services Clause Summary field now accepts 1000
characters. (Tri-75110-IV36816)

Lease Abstract and
Lease Abstract
Template

On the Lease Abstract and Lease Abstract Template, the fields in the Default
Remit To section are not cleared when a different Remit To Look Up value is
selected. The Update Payment Instructions action updates the Payment
Schedules with the selected Default Remit To data. The Remit To Look Up
clear icon clears the data in all fields in the section. (Tri-78826-IV37433)

Lease Clause

Rearranged the fields in the Alterations section of the Lease Clause and
Lease Clause Template forms to match the layout of the Alterations section
on the Rights tab of the Lease Abstract form. (Tri-72751)

List Manager

A new list named triBillingTypes replaces lists named GE Billing Types
and triGEBillingTypes. The values in the triBillingTypes list are
First and Second. The triLeaseAllocations, triSpaceAssignments,
and triSpaceUseAgreement business objects now reference the new
triBillingTypeLI list. (Tri-81642-IV38448)

Location Hierarchy Space and Space
Group

The Percent Occupied (c/d) field on the General and Allocation tabs of the
Space and Space Group forms has been relabeled Ratio Occupied (c/d). This
field shows a decimal value, not a percentage. (Tri-78704-IV37437)

Metric Report

Corrected an issue where Building System Item Replacement Value was
incorrectly added with Calculated Replacement Cost of the building to
calculate the Green Condition Index Ratio metric report. Also corrected an
issue where the Green Condition Index Ratio was incorrectly summed,
instead of averaged, when viewed through the Geography or Capture Period
drill path. (Tri-70303-IV33565)

Move Request

In the Move Services form, the section actions on the Move Items section now
are disabled when the Move Services record is in a null state. Users cannot
add a Move Request Line Item until the Move Services record is created. This
method prevents the creation of orphan Move Request Line Item records.
(Tri-73705-IV33142)

Owned Property

On an Owned Property, the Include in Amortization Schedule check box is
hidden for all Payment Schedules created using the Generate Payment
Schedule process. (Tri-72830)

Portfolio > Location

Spaces added to the Space Group hierarchy are now displayed in the Spaces
query section of the Space group record. The association on space query is
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changed from Has to Is Parent Of. (Tri-70313-IV33982)

Projects > Real
Estate

The hierarchical query in the Transaction Plans, RE Projects portal section
now displays the child project records. Previously, only the parent record
displayed. (Tri-71112-IV36161)

RE Lease - Straight
Line

Straight Line Rent Liability payments are no longer displayed on an RE
Invoice, Asset Invoice, or Process Payment. (Tri-73702)

RE Project
Acquisition

The Purchase Terms section has been moved from the Offer Information tab
to the Financial Terms tab on the RE Project Acquisition form. (Tri-91200)

RE Project
Disposition

The Details of Sale section has been moved from the Offer Information tab to
the Financial Terms tab on the RE Project Disposition form. (Tri-91201)

RE Projects

The Commencement Date on the Financial Terms tab of all RE Project forms
is changed from "Required" to "Not Required (Optional)". The affected forms
include RE Project Acquisition, RE Project Current Terms, RE Project
Disposition, RE Project Expiration, RE Project Lease, RE Project Sublease,
and RE Project Termination. (Tri-73008)

RE Transaction

On the Transaction Plan, when you create a RE Project within that plan, it
creates a scenario. On the Summary Metrics tab of these scenarios, the
financial information rolls up to this form. These calculations have been
updated to perform the calculations correctly. The summary metrics on all
RE Project forms are calculating correctly now. The reports and NPV values
on the Transaction plan are calculating correctly now. (Tri-73656-IV37460)

RE Transaction

On the Transaction Plan, when you create a RE Project within that plan, it
creates a Transaction Scenario. On the Summary Metrics tab of the
Transaction Scenario, the financial information rolls up to this form in the
P&L Impacts section. The profit and loss (P&L) values have been updated to
perform the calculations correctly. (Tri-70456-IV36355)

RE Transaction Forms

There are multiple form changes on the Financial Terms tab of the RE
Project Acquisition, Disposition, Termination, and Expiration. The changes on
these forms were to adjust what is displayed to better represent what is
used on each form. All the financial information has been taken from the
Site Information tab and moved to the Deal Terms section on the Financial
Terms tab. (Tri-83345)

Real Estate Lease

In the Payment Amount Calculations section of the Payment Terms form, the
label “Monthly Amount” has been changed to “Period Amount”. (Tri-84432)

Real Estate Lease

Resolved rounding inconsistencies between the calculation of the Annual
Amount in the Payment Schedule query section and the Cost/Unit (Year) *
Contract Rentable calculation. The value displayed in the form has two
decimal places; however, the value stored in the database has six decimal
places. The database value with six decimal places is used for calculations.
(Tri-86721)

Real Estate Lease

When a lease is amended, the value for Charge Amount Basis is now correctly
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Description
mapped to the History record of the payment schedule. (Tri-86734)

Reports

Resolved an issue that caused errors in the following reports in Microsoft SQL
Server environments: Asset Lease Assumption Audit Log Report, Lease
Assumption Audit Log Report, triAssetLease - BIRT - Asset Lease
Assumption Audit Log, and triRealEstateContract - BIRT Lease Assumption Audit Log. (Tri-89936)

Requests

On a request, when the Someone Else option and a different Requested For
person are selected, the Location and Organization under the Request
Details section now map correctly into the Primary Work Location and
Customer Organization fields respectively on the work task that is created
when the request is submitted. (Tri-83540-IV39026)

Requests

On an Individual Move Request, the To Location is now copied to the Move
Request Line Item if it is populated after the request is in draft mode and
the user clicks the Submit action. (Tri-73385)

Requests

On the Request record, when the Requested For is changed to another
person, that person's organization is now correctly updated in the Request
Details section. (Tri-73707)

Requests

On the Request record, when you change the Request is for option from
Someone Else to Me, the Requested For and Request Details sections are
populated with the Work Phone, Email, Primary Location, and Primary
Organization data corresponding to the Requested For person.
When you change the Request is for option back from Someone Else to Me,
by design the Location data is not updated with the Me person data.
(Tri-79623-IV38409)

Requests

The value for Request Class on the work task is now correctly mapped from
the work task template, rather than the request itself, when a service
request creates work tasks. If the Request Class is not defined on the
template, then the work task maps the value from the service request.
(Tri-74008-IV33506)

Requests

Under the Service Request section on the Request form, the selected option
remains selected or another option can be selected when the Request is for
option is changed to Someone Else and the Requested For person is changed.
(Tri-79610-IV38020)

Reservation and
Contracts

Additional feature added to view account code and charges along with
encrypted credit card details, if applicable. (Tri-68939)

Reservation form

Added a Default Layout column to the Reservation queries for Location
Reservation, Concierge and Preferred Queries. (Tri-89176)

Reservation Reports

Added reports for equipment reservations and vehicle reservations to view
the reservation along with the assets that were reserved. The affected
reports are as follows: Reservations (Today), Reservations (Today and
Future), Reservations (This Week), Equipment Reservations (Past), and
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Location Reservations (Past). (Tri-68882)

Select Equipment
form

The Select Equipment form now shows the same Available Equipment when
accessed from different locations. (Tri-84254)

Service Plan

When creating a Facility Project Template that has Task templates and the
record is being created through request with a Service Plan, a new rule has
been added in the Service Plan. When Task Assignment Rule equals "Autoassign to Service Provider", the Task Assignment Date Rule now has "Use Task
Template". This allows the Task within a Facility Project to use its Task
Template to map the dates rather than the Service Agreement. (Tri-70487IV36001)

Straight Line
calculation on Asset
Lease

When straight line adjustments are used in conjunction with a partial
payment schedule, the last payment line item now has the correct Expected
Accrual value. When the Payment = Straight Line/Month, accrual values on
PLIs when the expected accrual value should be 0 are now calculated
correctly. When the Lease Treatment is Operating, the value of the
Operating Portion of Capital Lease field is not used in the Straight Line Rent
Liability calculation. When the sum of the Straight Line Rent Capital Portion
PLIs does not add up to the necessary total due to rounding, the additional
PLI that is created is now created with the correct value. (Tri-72452)

Tools >
Administration

Removed an unnecessary Copy action from the CAD Mapping form.
(Tri-73164-IV36348)

UOM_Value

The value for the Area (Imperial) field of the Space Measurements section of
a Space record is now calculated correctly. The conversion value in the "Area
- square-meters" UOM_Value record was corrected to 10.76391042.
(Tri-74003-IV34565)

Workplace
Reservation Manager

A reservation now respects the minimum order time for food orders as
defined in the blanket purchase order. If a reservation is within the minimum
order time, the user cannot see or select food items. (Tri-68933)

Workplace
Reservation Manager

Added a new report to the Reservation Coordinator portal that shows a
graphical representation of reservations for the next 30 days. (Tri-68971)

Workplace
Reservation Manager

Added a report to the Reservation Coordinator portal that makes it possible
for the user to query for reservations in the past. (Tri-68893)

Workplace
Reservation Manager

Now users can modify the Date/Time and Subject while on the TRIRIGA tab
within Outlook. Previously these fields were read-only. (Tri-68949)

Workplace
Reservation Manager

The start and end date and time in a reservation-related notification is now
converted to the user's preferred format and time zone. (Tri-68999,
Tri-75229)

Workplace
Reservation Manager

The TRIRIGA Workplace Reservation Manager now can be used to create
reservations in the past. This change accommodates the use case where an
end user or a concierge uses a reservable location, but the data needs to be
back-dated for utilization metrics. (Tri-71558, Tri-73571)
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Workplace
Reservation Manager

Users can now check in from the reservation user interface. Prior to this
change, the check in process was only accessible from the email notification.
(Tri-70249)

Workplace
Reservation Manager

When a recurring reservation created in IBM TRIRIGA is imported into
Outlook, all occurrences of the appointment appear in Outlook instead of
only the first occurrence. (Tri-70128)

IBM TRIRIGA 10.3.0.1 Changes
You upgrade your version of IBM TRIRIGA for this release by fix pack. The 10.3.0.1 fix pack includes an
object migration package. Do not apply the 10.3.0.1 object migration package on versions of IBM
TRIRIGA before version 10.3. To upgrade to IBM TRIRIGA version 10.3, follow the instructions at the
following link: http://www.ibm.com/support/docview.wss?uid=swg24033724.
To download the 10.3.0.1 fix pack, go to Fix Central at the following link:
http://www.ibm.com/support/fixcentral. In the Find Product tab, select IBM TRIRIGA Portfolio Data
Manager and the 10.3.0.1 package. Download the readme file and the object migration package
appropriate for your operating system. Follow the directions in the readme file.
The changes to IBM TRIRIGA for this release include the following:
Area of Change

Description

Real Estate Lease

In the Payment Amount Calculations section of the Payment Terms form, the
label “Monthly Amount” has been changed to “Period Amount”. (Tri-84433)

Real Estate Lease

In the Payment Parameters section of the Generate Payment Schedule form,
the label “First Payment Amount” has been changed to “Amount Per Basis”.
(Tri-72942)

Real Estate Lease

In the Payment Schedule section of the Generate Payment Schedule form,
the label “Monthly Amount” has been changed to “Period Amount”.
(Tri-72932)

Real Estate Lease

Resolved rounding inconsistencies between the calculation of the Annual
Amount in the Payment Schedule query section and the Cost/Unit (Year) *
Contract Rentable calculation. The value displayed in the form has two
decimal places; however, the value stored in the database has six decimal
places. The database value with six decimal places is used for calculations.
(Tri-86720)

Real Estate Lease

When a lease is amended, the value for Charge Amount Basis is now correctly
mapped to the History record of the payment schedule. (Tri-86731)

Real Estate Payment
Schedules

Frequency payment calculations now include the option to calculate with a
frequency of 13 periods per year.
The Charge Amount Basis values of per Area (Annually) and of per Area
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(Monthly) do not apply to an asset lease. Because the Generate Payment
Schedule wizard is a standard form, it is possible for a user to select these
values; however, the value of the Expected Cash Amount field on the
generated Payment Schedule form will be zero. (Tri-72939)

Real Estate Payment
Schedules

When the Frequency is Monthly and the Charge Amount Basis is per Area
(Monthly) or per Area (Annually), then the Cost per Unit field on the
Payment Schedule form is now calculated correctly.
When the Frequency is other than Monthly and the Charge Amount Basis field
is other than per Month, then the calculations of Period Amount, Annual
Amount, and Cost / Unit (Year) in the Payment Schedule query section of the
Generate Payment Schedule wizard are now calculated correctly. (Tri-72930IV34303)

IBM TRIRIGA 10.3 Enhancements
The enhancements to IBM TRIRIGA for this release include the following:
Area of Impact

Description

Reservation
Management

The enhanced IBM TRIRIGA Workplace Reservation Manager product manages
all schedulable resources in a single product; integrates with other IBM
TRIRIGA products for portfolio, web graphics, task, inventory and contract
management, and strategic facility planning; analyzes capacity; and
increases facilities utilization. The bi-directional integration with Microsoft
Exchange/Outlook delivers end-user scheduling directly through Microsoft
Outlook, including requests for related services and equipment. The software
supports flexible workspace programs. The interactive graphic (web graphic)
locator presents available locations. Utilization metrics analyze capacity and
increase utilization.

Environmental and
Energy Management

IBM TRIRIGA Real Estate Environmental Sustainability Manager enhancements
support global greenhouse gas reporting standards and compliance. Also,
with the addition of processing logs that contain failure point information for
both carbon calculations and ENERGY STAR ratings, you can more easily
locate errors so that you can fix them. You can then successfully receive
accurate carbon calculations and ENERGY STAR ratings.

Capital Project
Management

IBM TRIRIGA Capital Projects Manager now manages and displays project
costs in the local currency of the project. The currency unit of measure
(UOM) for the project is set by the person initiating the project. All of the
project objects then have the same currency UOM. Project-related financial
information is displayed in the project currency UOM, without being
translated to the base UOM and back to the project UOM.

Payment Schedule
Wizard

The payment schedule wizard now supports the definition of calendar
quarters that are different from the quarters used traditionally in US
accounting periods. A user creates one payment schedule record in the
payment schedule wizard with the specific quarter days selected. When a
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user activates a lease, payment line items for the defined quarter days are
created with quarter days as due dates for each payment line item.

Globalization

IBM TRIRIGA application instance data is available in 16 languages supported
by IBM TRIRIGA: Brazilian Portuguese, Chinese (Simplified and Traditional),
Czech, Dutch, French, German, Hungarian, Italian, Japanese, Norwegian,
Polish, Russian, Spanish, Swedish, and US English.

Carbon Calculations

The new carbon processing log stores failure point information related to
carbon calculations. A carbon processing log record is created every time the
job scheduler runs on the building record that was flagged to have carbon
calculation (Carbon Calculation Needed check box). The carbon processing
log is associated to the building (building, structure, and retail location) and
organization (My Company) record. (Tri-36502)

Energy Benchmarking
with ENERGY STAR

The new ENERGY STAR processing log stores failure point information related
to the ENERGY STAR rating process. An ENERGY STAR processing log record is
created for each error returned by the US Environmental Protection Agency’s
ENERGY STAR Automated Benchmarking Service (ABS) system in response to a
request for an ENERGY STAR rating. ENERGY STAR processing log records are
associated to the building (building, structure, and retail location) for which
the ENERGY STAR rating was being processed. (Tri-36504)

System Setup

Selecting the Help link on the Home page now redirects the user to the IBM
TRIRIGA Support site. There is a patch helper workflow to update existing
Help records. (Tri-39322)

IBM TRIRIGA 10.3 Changes
The major changes to IBM TRIRIGA for this release include the following:
Area of Change

Description

Application Setup
Manager

Corrected mapping for the Message Content Note in the Add Subject tasks for
the triIntegrationNotification - SEND - Create Email
Integration Notification workflow. (Tri-28564)

Application Setup
Manager

When multiple Headcount Demand Driver records are pulled into the
Forecast Standard form, each corresponding Forecast Demand Driver now is
created and the Standard Space Area column in the query section reflects
the correct value. (Tri-27829)

Asset Lease

The FASB 13 Treatment section is now available for asset leases. You use this
section to identify whether an asset lease is treated as an operating lease or
as a capital lease. (Tri-80665)

Assets

Attached appropriate queries to a few query sections that were missing
queries. (Tri-26554)
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Assets

In the Specification (Parts List) section of an asset, when the user selects
specs from the query, the system creates corresponding line items in the
section. (Tri-12100)

Assets

The Select Organization Lookup icon now displays the locator query in the
following forms: Core, Key, Key Ring, Locks, Office Equipment, Software
License, Technology Assets, Telephones, Tools & Test Equipment, Vehicles,
and Work Area Outlets. (Tri-36037)

Assets

The status of a copied Telephones record is Draft and shows as Draft in the
System tab. (Tri-36154)

Audit Space

On the Space Audit form, the Find action in Space Allocation section opens a
query section. (Tri-10651)

Audit Space

When a user selects the Close Audit Period action, the status of the Master
Audit record changes to History and the statuses of all Audit and Space Audit
- Allocation History records associated to the Master Audit change to History.
(Tri-27200)

Building >
Opportunity
Attribute

Cancelling an opportunity record when Type = Environmental no longer
causes the Environmental Opportunity Type field to disappear. (Tri-37371)

Capital Projects

When a draft capital project is activated, it is routed through the approval
process defined for the project record. In the past, when an active project
was revised and then reactivated, the approval process was bypassed. This is
no longer the case. An active project that is revised and then reactivated
now follows the approval process defined for the project record. Also, an
issue causing improper sequencing of the remaining reviewers whenever an
approval was returned has been resolved. Upon reactivating a project after
it has been previously returned, the approvals are now routed to the
reviewers in the sequence defined for the project. (Tri-37493)

Checklists

History records are no longer included in the results of the contract Find
query on the Contract Award Checklist form. (Tri-12138)

Classification
Manager

Now when you clear the Real Property Type field in the Real Property Use
Classification record, the Real Property Type ID field is also cleared.
(Tri-37003)

Classification
Manager

Resolved several issues that caused Copy actions to not work properly.
(Tri-37008, Tri-37009, Tri-37018, Tri-37019, Tri-37020, Tri-37089, Tri-37092,
Tri-37093)

Classifications >
Building System Class

An entry removed from the Repair Cost Estimate Items section no longer
reappears when the user saves the Building System Class record. (Tri-27356)

Classifications >
Time Zones

Added time zones for (GMT +8) Taipei Standard Time [Asia/Taipei] and (GMT
+9) Korea Standard Time [Asia/Seoul]. Corrected the time zone value for
(GMT +4) Moscow, St. Petersburg, Kazan, Volgograd [Europe/Moscow] and
(GMT -2) Mid-Atlantic Standard Time [Atlantic/South_Georgia]. (Tri-40330,
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Tri-40463)

Contract Manager

Added an association from triBlanketPurchaseOrder,
triServiceAgreement form, to the triProperty business object. Now a
property is reverse associated to the service agreement. (Tri-19141)

Contract Manager

Line Items now are removed when the Standard Contract reference is
cleared from a Standard Contract Change Order. (Tri-18789)

Contracts

A warranty in draft status no longer processes a new request or creates a
task; this does not occur until the warranty is in an Issued state. Tasks now
are activated when a task is created from a warranty (any type). A location
now is attached to the warranty whether the warranty is draft or issued.
(Tri-35873)

Contracts

Changed the query columns of the Payment Schedules section of the Real
Estate Lease and Owned Property (Fee) Agreement to be consistent with the
Rent Schedules section of the Lease Abstract. Also, changed columns of the
Rent and Expenses section of the Real Estate Lease Template and Scheduled
Payments section of Owned Property (Fee) Agreement Template. (Tri-20906)

Contracts

Revising a Service Agreement now creates a Service Agreement History
record and is visible in the Service Agreements - History subquery.
(Tri-15693)

Contracts

State/Province, County and Country fields are now mapped when the user
clicks the Create New City action. (Tri-20775)

Contracts

The Add Revision action on the Terms section in the Proposed Real Estate
Lease form now populates the Name, Lease Commencement Date, Lease
Expiration Date, and Current Fiscal Year fields with the values from the last
revision record. (Tri-12146)

Contracts

When a user selects One-time payment ("Other" in Frequency), only
Frequency, First Payment Date and First Payment Amount are shown in the
Payment Parameters section, with the Frequency field as the first field in
the section. Also, hid the Payment Schedule query section. Relabeled
"Covenant Frequency" to "Frequency" on the Generate Payment Schedule and
Payment Schedule forms. (Tri-36476)

Contracts >
Agreements

After a contact role is added to a service agreement and the service
agreement has been issued and then revised, the contact role can now be
removed or changed. (Tri-31909)

Contracts >
Agreements

The Amortization Schedule check box no longer shows on the Payment
Schedule form and the Generate Payment Schedule form if those forms are
from Owned Property (Fee) Agreement. (Tri-38258)

Contracts > Blanket
Purchase Orders

In the Products & Services tab, after you retire a product or service, the
status of the product or service changes to retired and the product or service
displays in the Retired Products and Services section. (Tri-15699)
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Contracts > Leases

% Change on Index Adjustment Calculator form now calculates the
percentage change between the Base Index and the New Index. (Tri-36003)

Contracts > Leases

A Payment Schedule Term record is not created if the value of Number of
Schedules is 0. You must enter a number in this field to cause the Payment
Schedule Terms to be created. (Tri-38034)

Contracts > Leases

Added the Include In Amortization Schedule field to the Generate Payment
Schedule form. The field is mapped from the Generate Payment Schedule
form to the Payment Schedule form when the user clicks the Create
Schedule(s) action on the Generate Payment Schedule form. (Tri-36484)

Contracts > Leases

Automatic calculation of the partial first and/or last payment (monthly) in
the Payment Schedule wizard is now correct for Asset Lease records.
(Tri-36478)

Contracts > Leases

Changed the label on the Software License form from triBuildingSystem to
Building System. (Tri-36807)

Contracts > Leases

Corrected a timing issue between asynchronous and synchronous workflows
in the calculation of partial payments for payment schedules. (Tri-37112)

Contracts > Leases

Corrected an issue that caused a duplicate payment line item to be
generated for the first month of a lease. (Tri-36193)

Contracts > Leases

Corrected the calculation of the Straight Line/Month field on the RE Lease
form by dividing by the accounting period instead of by the number of PLIs.
(Tri-37161)

Contracts > Leases

During the RE Project Expiration process, the Contract Status status field on
the Contract Terminate pop up now correctly maps the Contract Status
defaulted or changed on the pop up to the amended real estate lease record.
(Tri-36966)

Contracts > Leases

Fair Market Rate Value Calculator record is no longer created past the
Payment Schedule End Date. (Tri-39883)

Contracts > Leases

Field labels have been changed on the Green Lease Provisions tab of Lease
Abstract and Lease Abstract Template forms. The same changes were made
on the Lease Clause, Lease Clause Template, Asset Lease Clause, and Asset
Lease Clause Template forms. (Tri-36399)

Contracts > Leases

For Percentage Rent Reporting, the Tax Rate form pop up from the Tax
Exclusions tab is now read-only if the parent Percentage Rent Reporting
record is read-only (for example, Issue and Completed statuses). (Tri-36875)

Contracts > Leases

Frequency now displays on Payment Schedule records of a Real Estate
Contract record when completing a Lease Abstract record. (Tri-39628)

Contracts > Leases

If a lease has one time payment schedules defined, the values in the
amortization schedule and in the amortization summary section are now
correct. Before, the one time payment schedules were spread across the
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term of the lease, which was incorrect. The rent paid is now in the correct
fiscal period. (Tri-40154)

Contracts > Leases

Improved the performance the Save action and the Revise action on a RE
Lease record. (Tri-38723)

Contracts > Leases

Index Adjustment Value Calculator records are no longer created past the
Payment Schedule End Date. (Tri-39884)

Contracts > Leases

Lease Clause Template Copy action now copies all data from the original to
the Copy of... record. (Tri-38278)

Contracts > Leases

Legal Notification Date field in the Critical Dates section is now calculated
when the Legal Notice Date and Legal Notice Reminder duration are
populated. (Tri-38260)

Contracts > Leases

Now after clicking the Apply Template action, the Attention section shows
on the Asset Lease form. (Tri-36733)

Contracts > Leases

On a Payment Schedule, the Add Payment Schedule action now maps
contract rentable from the Real Estate Contract Premise Locations on the
Locations tab to the payment schedule. Cost per Unit and Annual Amount are
now calculated. (Tri-34515)

Contracts > Leases

On the Accounting tab of the Asset Lease form, corrected the spelling of the
label of the Balance Sheet Affect section. (Tri-37034)

Contracts > Leases

On the Asset Lease, when using the Payment Schedule Copy action, the Copy
of… Payment Schedule now shows the Unit Count and Units fields with the
correct UOM. (Tri-37574)

Contracts > Leases

On the Lease Clause record, fields on Payment Schedule and Option are
mapped with the fields on Payment Schedule and Option of the Lease Clause
Template record when the Lease Clause record is created from a Lease
Clause Template record. The affected fields are: For Payment Schedule Document Type, Section, Page, Abstract Notes, Option Term Payment, and
Covenant Frequency Type For Option - Document Type, Granted In Lease,
Section, Page, Abstract Notes, Rolling Option, and Effective to Date
(Tri-35924)

Contracts > Leases

Payment Schedules (Rent, Percent Rent, Commissions, CAM/OPEX,
Insurance, and Tax) associated to a Lease Abstract are now copied when the
user clicks the Copy action on Lease Abstract. (Tri-38619)

Contracts > Leases

Removed the Update Matrix action on the Default Matrix SLA Values section
of the Services tab of a RE Lease record. (Tri-36951)

Contracts > Leases

Resolved an issue that caused an extra payment line item to be created.
(Tri-36188)

Contracts > Leases

Resolved an issue that caused the browser window to remain processing
when a Payment Instruction was created with an organization that had a very
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long name or a very long address. (Tri-39587)

Contracts > Leases

Resolved several issues that caused missing payment line items when the
payment schedules started or ended in the middle of the month. (Tri-36366)

Contracts > Leases

Revising and reactivating a lease no longer blanks out the value in the
Notification column in the Lease Notifications section. (Tri-35979)

Contracts > Leases

Save and Save & Close actions are no longer available when the Lease
Abstract Issue record is in Status = Pending Abstractor and read only.
(Tri-35904)

Contracts > Leases

The Amortization values and summary are now calculated correctly when a
quarterly payment schedule is defined along with regular payment
schedules. Earlier, advanced schedules were not handled properly, which
caused amortization values to be incorrect. Note that only monthly and
yearly advanced schedules are supported. (Tri-40116)

Contracts > Leases

The Calendar tab is no longer visible on the Owned Property (Fee)
Agreement Template form. (Tri-38302)

Contracts > Leases

The Effective Date on the Renewal Option created using the Options Wizard
is being set correctly by taking the Renewal Expiration Date of the most
recent Renewal option plus one day. (Tri-37132)

Contracts > Leases

The layout of the fields in the Lease Clause Template for the Default clause
type now matches the layout in the Lease Abstract Default tab. (Tri-36045)

Contracts > Leases

The Notification Date (calculated) field is now recalculated if the value of
Notify me how long prior? is changed. (Tri-32597)

Contracts > Leases

The Post Type in the Payment Line Item record is now the same as the Post
Type selected in the Payment Schedule. (Tri-36012)

Contracts > Leases

The Premise Location section no longer includes retail center records. Also,
the Owned Property Locations tab, Primary Location section, Find action
query is now the same as the Primary Location Find query on the General
tab. (Tri-36326)

Contracts > Leases

The radio button for the clause is automatically selected if there is only one
clause in the query section when using the Find Template action. When there
is more than one clause selected from the Find Template action, the radio
option of the first record in the Lease clause query section is automatically
selected. If one clause is selected in the query section already, the selection
will be the same after selecting another Lease Clause from the Find
Template action. (Tri-35841)

Contracts > Leases

The Reports tab is hidden on all clause records on the Lease Abstract form.
(Tri-34348)

Contracts > Leases

The Reports tab on RE Lease form contains one BIRT report, the Lease
Assumption Audit Log Report. (Tri-20744)
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Contracts > Leases

The Unretire action on Asset Lease Template and RE Lease Template now
returns the record to Template status. (Tri-39970)

Contracts > Leases

The value selected for Insurance Carrier in the embedded section of a lease
abstract now maps to the Insurance Carrier field on the added clause.
(Tri-36055)

Contracts > Leases

Updated two workflows to remove switches that did not have conditions:
triRealEstateContract – Synchronous – Make Dependant
Records Editable and triRealEstateContract – Synchronous
Read Only Dependant Records. (Tri-35687)

Contracts > Leases

When a lease is revised and the proportionate share is modified in the
clause, this change is now carried into the Schedule OPEX/CAM
reconciliation. Added Refresh OPEX/CAM Details actions on the Premise
Location section of the RE Lease and on the Services Included section of the
Lease Clause to update the proportionate share value on Lease Clause and
Reconciliations. (Tri-39184)

Contracts > Leases

When a user selects One-time payment (Frequency = Other) and selects the
Generate Payment Schedule action in the Payments tab, Payment Schedules
sub-tab, the system creates the correct schedule. (Tri-36529)

Contracts > Leases

When making a copy of an Asset Lease that has a payment Schedule, the
copy of the associated payment schedule that is in the Copy of… Asset Lease
record now shows the Unit Count and Units fields with correct UOMs.
(Tri-37575)

Contracts > Leases

When straight line adjustments are used in conjunction with a partial
payment schedule, the last payment line item now has the correct Expected
Accrual value. (Tri-38463)

Contracts > Leases

When the Advanced Payment Schedule record is saved, if the Start Date is
greater than the End Date, now a validation Attention message displays.
(Tri-35879)

Contracts > Leases

When the Lease Treatment is Operating, the value of the Operating Portion
of Capital Lease field is not used in the Straight Line Rent Liability
calculation. (Tri-37935)

Contracts > Leases

When the Payment = Straight Line/Month, accrual values on PLIs when the
expected accrual value should be 0 are now calculated correctly. (Tri-39834)

Contracts > Leases

When the sum of the Straight Line Rent Capital Portion PLIs does not add up
to the necessary total due to rounding, the additional PLI that is created is
now created with the correct value. (Tri-37962)

Contracts > Leases

When you remove an option in a RE Lease, it is now deleted. (Tri-37244)

Contracts > Leases

Within the same month and year, regardless of payment types, the PLIs are
split proportionally. (Tri-37389)
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Contracts > Leases

You use the field named Time Zone used to calculate contract payment
schedule that is now in Application Settings > Lease Accounting Settings >
Payment Schedule Settings to establish whether the system’s or the user’s
time zone is used to calculate payment schedules.
The Event object now includes a field named triTimeZoneId, which
contains the value from the Time Zone used to calculate contract payment
schedule field in Application Settings. The triTimeZoneId field is used to
calculate payment schedules that create Event records. (Tri-36970)

Contracts > Leases

You use the Units section to change the Currency UOM on the Asset Invoice
form or the RE Invoice form to be different from the associated contract.
(Tri-36375)

Contracts > Payables

Only payment amounts greater than zero are applied when processing
Receive Lease Receipts. (Tri-39420)

Contracts > Payables

When a RE Invoice is revised, it creates a history RE Invoice which
inadvertently created two payment vouchers. Now the RE Invoice only
creates one payment voucher. (Tri-39643)

Contracts > Payables

When creating a One Time Payment from an Asset Invoice using the Quick
Add method, the Asset Lease name on the One Time Payment record is no
longer marked as required. Both the RE Contract and Asset Lease smart
sections were visible on the One Time Payment form. Now, if displayed from
an Asset Invoice, the RE Contract section is hidden, and if displayed from a
RE Invoice, the Asset Lease section is hidden. The applicable contract from
the Invoice is now prepopulated on the One Time Payment form. (Tri-37241)

Contracts > Prime
Contracts

Added the Remove action to the Contacts section of the Prime Contract form
and the Prime Contract Change Order form to make it possible to remove
contact records. (Tri-39725)

Contracts >
Receivables

Resolved an issue in the Process AR Receipts form that caused the Find
action on the AR Payments Due query section to not display applicable
payment line item records from the associated contract. (Tri-37965)

Contracts > Warranty

When a warranty contract is retired, associated SAM records are deleted.
(Tri-34114)

Cost Codes

Adding a new Cost Code no longer defaults the Name field to Cost Code.
(Tri-40468)

Cost Estimates

When you Retire a Geography Cost Index record that is in Revision in Progress
status, the Status Value now displays as Retired. (Tri-16531)

Document
Management

The Publication form now has Revise and Retire actions when it is in the
Published state. (Tri-17142)

Energy Rating

When creating a subsequent energy rating record for a building, the Other
Subtype field is now mapped correctly. (Tri-36841)
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Form Runtime

Now the Attention section of a Lease Clause Service record is no longer
visible when there is no data in this section after the user cancels out of the
page and then reopens it. Retired the Workflow triLeaseClauseService
- Cancel -Reset Meta Date. (Tri-23707)

Forms

Updated the query sections for the following forms: triAsset,
triAssetOffline, triCatalog,
triContractNotificationAssetLease, triCore,
triDuplicateRequests, triInventory, triIssue, triKey,
triKeyRing, triLocks, triOfficeEquipment,
triPWServiceManagerEditServiceAgreement,
triPermitApplication, triProductContractServicesRequest,
triResolutionOption, triServiceExcluded, triSoftwareLicense,
triSolution, triTechnologyAsset, triTelephones,
triTimeCategory, triToolsandTestEquipment, and
triWorkAreaOutlets. (Tri-36932)

Funding Requests

Funding Analysis now displays names instead of numbers when comparing
funding requests. (Tri-23339)

Funding Sources

Performing a Program fund transfer for a given funding source and year no
longer results in the transfer amount being applied to each Program funding
source having that same year. (Tri-36151)

Gantt

The value in the Working Hours Per Day Used For Scheduling field in a
Calendar record now must be greater than 0 and less than 24. (Tri-21097)

General Evaluation

The Find action on the Survey Recipients section of the General Evaluation
Request form now only refers to Employees and Consultants. (Tri-19749)

Generate Payment
Schedule form and
Payment Schedule
form

The calculation of '13-period' frequency is now added to frequency payment
calculations.

Generate Payment
Schedules

Resolved an issue that caused a partial year schedule created by modifying
the end date of the last scheduled year to stay in processing status.
(Tri-37184)

Globalization

Removed all labels from the as-delivered products that were not in US
English. (Tri-35827)

Inventory > Manage
Inventory

Inventory Quick Fill units are now correct. The Quantity UOM and Currency
UOM are populated from the Inventory Item. (Tri-38095)

Inventory > Manage
Inventory

The triInventoryBillofMaterials - Synchronous - Calculate
Actual Cost workflow now calculates Quantity Issued and Quantity
Returned from the triInventoryTransactionItem records, similar to

The Charge Amount Basis values per Area (Annually) and per Area (Monthly)
do not apply to the Asset Lease. These values can be selected since Generate
Payment Schedule is a common form, but the Expected Cash Amount on the
generated Payment Schedule form will display zero. (Tri-70797)
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Cost Issued and Cost Returned. With this change, the task’s Inventory Bill of
Materials record now more accurately reflects actual quantities. Also, new
fields added to the task's section queries
(triInventoryBillofMaterials - Display - triTask
Consumable and triInventoryBillofMaterials - Display triTask Assignable) improve the data available to the user about each
line item was processed. (Tri-37100)

Inventory -> Manage
Inventory

Inventory Manager form when doing inventory items adjustments the
quantity unit of measure is now pulling from the inventory item. (Tri-37967)

Inventory > Manage
Inventory > Items

The Order/Receipt, Hold, Issue, and Adjustment/Transfer section actions are
inactive until the record is created. (Tri-37715)

Lease Abstract

The Area Units field on a Lease Abstract now is pre-populated with the value
of the Area Units field in the logged in user's My Profile record. (Tri-36622)

Lease Abstract

The Copy action on a Lease Abstract now also copies the premise location
record. Changes that are made to premise location details in the original
record no longer affect both records. (Tri-36400)

Lease Abstract

When selecting a Responsibility Services record from a query section on
Lease Abstract, fields in the Clause Details and Responsibility Service
sections are changed accordingly. If a user selects a Responsibility Services
record and clicks Cancel instead of Save on the Lease Abstract, the next time
the user opens this record, the default radio button is where it was last
saved. (Tri-38521)

Leases

The Graphic Find action on the Service Locations tab of the Real Estate
Lease Template form is now hidden. (Tri-36034)

Lists

Removed DateTime formats containing both HH and a, such as yyyy/MM/dd
HH:mm a zz, because the a indicates an AM/PM designator for an HH 24hour clock. (Tri-37281)

Locations > Land

Added a formula for CO2, N2O, and CH4 Equity Share and Equity Share
Reporting fields on the Scope 1 (Direct) Summary section of the
Environmental tab on the Land form. (Tri-37380)

Maintenance

For records in Active status, a Checklist Item that is manually added has a
retire action as does a Checklist Item created from a Checklist Item
Template. (Tri-17643)

Maintenance ->
Analyze Opportunity

Resolved the issue causing opportunities from a funding analysis to not be
copied to the new funding request. (Tri-37482)

Maintenance >
Facility Assessment

Added the BST Approval Template record. It links to the Building System
Template Approval Requirement record. If you have created an approval
template record with a similar name, you need to make sure your users
understand which record to select in the Approval Requirement records.
(Tri-33347)
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Maintenance >
Facility Assessment

Bulk Print actions for all task types on the Maintenance Manager form now
print all selected task records whether or not they are created under a
project level. (Tri-36480)

Maintenance >
Facility Assessment

Now the results in the Opportunity Analysis section are the same for
Opportunity and Funding Request records. (Tri-36114)

Maintenance >
Preventive
Maintenance

Replaced the sentence for Yearly Recurrence on the PM Event form with
Sequence, Day and Month labels for each list field. (Tri-36863)

Maintenance >
Procedures

Currency fields in the Details section of Safety Precautions Procedure,
Inspection Procedure, Lock-Out / Tag-Out, and Safety Hazards Procedure
forms are now right aligned. (Tri-36634)

Manage Requests

By design, the Service Request section is hidden when the service request
record is in Issued status. However, the selected Service Request is
populated to the field (Service Requested) in the Request Details section,
and this field is visible when the service request record is in Issued status.
(Tri-35930)

My Reports

Added runtime filters for Payment Type, Accounting Type, Due Date (Before)
and Due Date (After). (Tri-21010)

My Reports

Changed the Reset Capture Period flag to be cleared in the following Reserve
Job Schedules. Checking this flag causes other metrics to not render
correctly.
 DEFAULT Reservation Resource (Asset) Day Fact Load Table
 DEFAULT Reservation Resource (Location) Day Load Fact Table
(Tri-38324)

My Reports

Now the Currency indicator in the Portfolio Summary Report is displayed and
changed according to the user's selection. (Tri-36643)

My Reports

Removed developer notes from the report description of the Financial and
Activity Report, Funding Notification Report, Program Specific Recovery Act
Report, Move From/To Details Report, and the Move From/To Summary
Report. (Tri-28518, Tri-28521)

My Reports

Resolved issues in the following BIRT reports that prevented the report from
rendering or that entered random values in the fields in the parameter box:
Potential Change Order Summary, Space Class Summary by Geography, and
Funding Source Summary Report. (Tri-36653)

My Reports

Symbol is changed throughout when Currency parameter = Currency
Conversion and To Currency parameter is any currency. The changes are
made to the BIRT reports listed below.
 triRealEstateContract - BIRT - Accounts Payable
History
 triRealEstateContract - BIRT - All Future Lease
Obligations
 triRealEstateContract - BIRT - AR Aging
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 triAssetLease - BIRT - AR Aging for Asset Lease
 triRealEstateContract - BIRT - AR RE Contract Payment
Details
 triAssetLease - BIRT - AR RE Contract Payment Details
for Asset Lease
 triRealEstateContract - BIRT - Contract Payment
Details
 triRealEstateContract - BIRT - Contract Summary Report
 triRealEstateContract - BIRT - Future AR Payments
 triAssetLease - BIRT - Future AR Payments for Asset
Lease
 triRealEstateContract - BIRT - Future Rent Obligations
Detail
 triRealEstateContract - BIRT - Future Rent Obligations
Detail for Asset Lease
 triRealEstateContract - BIRT - Portfolio Summary
Report
 triRealEstateContract - BIRT - Tenant Aging Report
(Tri-36566)

My Reports

The Active status filter has been renamed to Issued for the triContract REPORT - Contract Execution Report for Bin3 report. (Tri-24694)

My Reports

The parameters are now correct in the Bulk Print RE Invoice and Bulk Print
Asset Invoice BIRT reports. (Tri-36635)

My Reports

Updated the extended formula on the triContractPaymentsNU field.
(Tri-36938)

My Reports

Updated the Survey Fact Table to get the correct location on the general
evaluation. Also corrected Responsible organization and Responding
organization data in Survey metric queries. You must recapture the survey
fact in order show the results correctly. (Tri-39157)

My Reports > System
Reports

Run the 10.3 patch helper workflow to fix an issue causing time zone
classification records to not be associated to the status classification.
(Tri-35766)

Notification
Requirement

For Real Estate Transaction Management users who do acquisitions (only),
the shipping Notification Requirement record on RE Project Acquisition has
been removed. This record will not be installed with future releases (new
install). If an upgrading customer would like to remove this, you can do it
manually. (Tri-36915)

Notifications >
Notification
Requirement

Notification of a completed work task is sent once instead of twice.
(Tri-36637)

Object Migration

If the Threshold type selected does not match the Detail section, run the
triPatchHelper - triCalculate - 10.3 - Fix Thresholds
workflow. (Tri-31397)

Operations > Contact

The Clear action in the General section now clears the values in the Problem
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Center Manager

Asset and Problem Location fields. (Tri-29619)

Organization
Manager

The reverse association of Organization - Parent Level 3 - Organization on
the Organization business object now is set correctly and matches other
Parent level (0, 1, 2, 4, and 5) associations. (Tri-20255)

Payables > Invoices

In PO Invoice, the Organization field now populates correctly when the user
clears the Organization field and selects a new organization. The
Organization field now populates correctly when the user changes the user
after selecting the To Lookup link. (Tri-13388)

Payables > Payments
> Release

The Vendor Company Lookup in the Payment Release form now defaults to
External Contact instead of Employee. (Tri-28155)

Payments

When the user completes a prime contract change order, if the prime
contract change order has prime contract change order line items with cost
codes, the system appends the cost code from the prime contract change
order line item to the Cost Transaction Codes section of the Financial
Transaction form. (Tri-19691)

Percentage Rent
Reporting

Percentage Rent Reporting action items now are removed from the user’s
Home page Action Items list after the records have been issued. (Tri-36914)

Plan > Space
Allocation Manager

Changed the label from Seat Occ Pct to Seat Occ Pct (e*100/f) in the
Portfolio Summary section of the Area Level Allocation form. (Tri-8702)

Plan Moves

The Add Room action on the Move Line Items for Selected Request section of
the Move Planner form now correctly maps a Location record. (Tri-27814)

Portfolio > Asset
Manager

Resolved the issue that prevented the Graphics tab on Asset forms from
displaying the applicable graphic (for example, a floor plan). (Tri-31897)

Portfolio > Assets

Removed the Add action on the MTBF Log tab and Downtime Log tabs on the
History tab of a Building Equipment Asset record. (Tri-36652)

Portfolio >
Environmental
Manager

A Carbon Log is now created for a building that has Waste Log data but no
Energy Log data or Travel Log data. (Tri-36609)

Portfolio >
Geography

Adding a city to a building now creates the correct association between
triBuilding and triCity. (Tri-33227)

Portfolio > Location >
Floor

In the Area Measurements tab of a Floor record, the values for Imperial and
Metric now display the correct data. (Tri-37172)

Portfolio > Locations

The carbon calculation UOM is now applied from the building into the carbon
log record. (Tri-36912)

Portfolio > Locations

The Floor Cost per Sq Unit field on the Allocation tab of a Space/Space
Group record is now mapped with the value in the Cost per Sq Unit field on
the Floor record when the Space record is first created. (Tri-33224)
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Portfolio > Locations

When a floor record is retired, the system updates the Rentable Area field
and Usable Area field on the Area Measurements tab of the building record.
(Tri-36251)

Portfolio > People

Each security group and license can be added only one time. Even if a user
attempts to add a group or license more than once, the system does not add
it more than once. (Tri-13266)

Portfolio > People

Resolved an issue that caused the user who created or modified the record
to be displayed in the System tab as System, System instead of the actual
user. (Tri-37782)

Portfolio > People

Updated the list of languages on the Profile tab of the Employee record.
(Tri-36610)

Portfolio > Planning
Manager

Space Plans are added from Portfolio Plans. Removed the Add action from
the following reports:



All Space Plans/Scenarios
My Space Plans/Scenarios (Tri-27729)

Portfolio > Planning
Manager

User messages are no longer hardcoded through workflow. (Tri-27573)

Portfolio > Project
Manager

The editable query for the Project Original Budget Template Items in Project
Original Budget Template records now includes fields to input budget
amounts. (Tri-22823)

Portfolio > Project
Manager

The values of the Importance Ranking field and the Importance field are now
cleared when the user changes the Use In Evaluation check box from
selected to cleared. (Tri-23237)

Prime Contracts
Change Orders

Updated the Contracts menu and portal section to include links to Prime
Contract Change Orders. (Tri-36979)

Procedures

When creating a procedure, clicking the Add action on the Materials sub-tab
from the General tab opens a new Specification Bill of Materials. The Status
field in the Bill of Materials record no longer contains the current user’s
status. (Tri-31604)

Process AR Receipts

When there is an AR Receipt Credit on the associated RE Contract, the
system now pulls this amount into the Credit Balance field in the Payment
Details Section on the Process AR Receipt form. (Tri-36116)

Procurement

Removed the triPurchaseOrder - Synchronous triCompleteFinalHidden workflow in the Complete Final Hidden
subaction of the state transition of the triPurchaseOrder business
object. (Tri-18532)

Procurement > Credit
Cards

The selection of a contact in the Purchased From section of a Procurement
Card Line Item no longer changes the Organization in the Purchased By
section to the value in the Purchased From section. (Tri-23439)
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Procurement >
Purchase Order

The Clear action in the Blanket Purchase Order section of the Purchase Order
form now clears the associated Blanket Purchase Order. (Tri-27669)

Product Request

Retired records no longer display when the user selects the Search Catalog
link on the Products Requested section in the Product Request form.
(Tri-23759)

Project > Budget
Manager

A user message now displays when an invalid value is entered into the Details
section on the Spend Plan tab of the Budget. (Tri-25777)

Project > Budget
Manager

Currency on the budget (Original Budget, Budget Change, Forecast and
Transfer) defaults to the same currency as its parent capital project. The
currency field in budget forms now is read-only. (Tri-19577)

Project > Budget
Manager

Improved the user messages on the Spend Plan tab of a Project Original
Budget form. Instead of one combined message, now there are separate
validation attention messages, one for percent of duration when half the
budget will be spent and the other for Growth Value. (Tri-25964)

Project > Budget
Manager

The BO Mapping for the triLineItemSummary business object in the
triCostItem module no longer points to a field that does not exist.
(Tri-29586)

Project Templates

The Copy action in the Capital Project template form now copies the
template correctly. (Tri-17559)

Projects

Added an In Service date field to a Retail Location record created from a
Proposed Retail Site record when the project is closed out. The In Service
date is the Commencement Date from the RE Lease Project form, Financial
Terms tab. (Tri-13051)

Projects

After funds are transferred via the Fund Allocation section of the Budget tab
of the Capital Project form, the values are now correct in the Funds
Available column in the Requested Project Fund Transfers from Funding
Source section. (Tri-37060)

Projects

Improved the Cash Flow Graph report. It now includes the series name and
the point data value in the hover tooltip. (Tri-36607)

Projects

On the General tab of the Prime Contract in the Bill To section, the First
Name and Last Name fields are no longer required fields. (Tri-37618)

Projects

Resolved incorrect mapping into a locator field in Apply Template workflows
on original project budget. (Tri-28469)

Projects > Budget

Corrected inconsistencies in the display of currency UOM. (Tri-36396)

Projects > Capital

When the new field Enable in Draft Mode in the Project Security section of
Application Settings is selected, a user with the appropriate security can
select the Apply Template action on a Capital Project. (Tri-39468)
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Projects > Contract

All fields in the Summary section of the Standard Contract form display the
currency UOM from the user’s My Profile. (Tri-37388)

Projects > Contract

Contract Invoice Line Item Amounts are no longer doubled when multiple
change orders are present. (Tri-39821)

Projects > Contract

On the Purchase Order form, the Total Invoice field now displays the total
invoiced value from the associated purchase invoice. (Tri-36650)

Projects > Facilities

Planned End Date no longer always has the same value as Planned Start Date
in the Facility Project. (Tri-39503)

Projects > Funding
Requests

The Net Investment Cost on the Evaluation tab of a Funding Request now
includes rebates when performing the funding analysis calculations.
(Tri-36040)

Projects > Funding
Requests

When the Use In Evaluation field is selected, objectives and risks now
populate from the program to the funding request even if the required
request type is not populated before the user creates a draft record.
(Tri-36672)

Projects > Progress

The Organization field on the To section of the Potential Change Order form
now displays the organization name instead of the whole path. (Tri-32567)

Projects > Real
Estate

Added as child classifications to RE Moving Costs in the Cost Type
Classification: Purchase Cost, Financial Category = Purchase Cost and
Purchase Price, Financial Category = Purchase Price. (Tri-37564)

Projects > Real
Estate

An empty Premise Location record is no longer created when an RE Project
(new Lease) creates a Lease Abstract. (Tri-36812)

Projects > Real
Estate

During the RE Project Termination process, a Contract Status field was added
to the Contract Terminate popup. Workflow now properly maps the Contract
Status defaulted or changed on the pop up to the amended real estate lease
record. (Tri-36967)

Projects > Real
Estate

In the RE Project Termination form, Percent is now read-only for the Lease
Termination Cost (% of Remaining Obligation) field and the Lease Buyout (%
of Remaining Obligation) field on the RE Project Termination Site
Information tab under the Details of Termination Or Buyout section.
(Tri-36940)

Projects > Real
Estate

On all RE project forms, the field labeled Annual Rent Expense was relabeled
to Average Annual Rent. Also, the formulas used to calculate the Average
Annual Rent and the Total Commitment were updated and improved. Both
now subtract sub-lease rental income. (Tri-36916)

Projects > Real
Estate

Percent is now read-only for the Acquisition Costs, Commissions, and Closing
Costs fields on the RE Project Acquisition Offer Information tab under the
Purchase Terms section. (Tri-36941)

Projects > Real

Purchase Price has been added to Financial Category Classification under 3
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Estate

Yr Cash Flow. Also Purchase Price has been selected in Financial Categories
section of Acquisition record under Project Type Classification. (Tri-37568)

Projects > Real
Estate

Save and Save & Close actions are now available when RE Project Lease or
Acquisition records are in Planning status. (Tri-36538)

Projects > Real
Estate

The Lease Option is now editable on a contract amendment action item.
(Tri-36357)

Projects > Real
Estate

The RE Project Template list displayed by the Apply Template action on the
RE Project form no longer includes retired records. (Tri-32169)

Projects > Real
Estate Lease

A RE Project Lease when closed out creates the correct preferred provider
evaluation survey and portfolio manager evaluation survey. (Tri-40011,
Tri-40013)

Projects > Schedule

Hid the Run Process action on System Job Scheduler, System Job Item, and
Job Scheduler forms. (Tri-36977)

Proposal Manager

Users now can add licenses to an External Contact record in a project
context. (Tri-10007)

Proposals

In the RFP form, all fields in the Vendor Company section and the Bill To
section are now populated from the Standard Contract record, as well as the
Cost Form section in RFP record. (Tri-22481)

Proposals

In the RFP form, the Vendor Company Lookup query now defaults to External
Contact instead of Employee. (Tri-28236)

Query and Reporting

Changed the reverse association to No for the following queries:
triJobPlan - Display - triMaintenanceManager - Responsible
Org and triJobPlan - Display - triMaintenanceManager Service Provider Org. Also corrected the association types in the
Association filter. (Tri-30297)

Query and Reporting

Changed the reverse association to No for the following query:
triMoveRequestLineItem - Display - Associated Task Query.
(Tri-22458)

Query and Reporting

The My Active Request report performs a descending sort correctly. Apply
the SQL script to update the system fields with sub-attribute type of
CreatedDateTime to CreatedDateTime (Number) and
ModifiedDateTime to ModifiedDateTime (Number). Oracle and
Microsoft SQL Server scripts are located on the upgrade disk in the
\Scripts folder. Instructions are within the scripts. (Tri-32473)

Query and Reporting

Updated the subqueries in Key Request and Product Request so they are
consistent. (Tri-17581)

RE Projects

On each RE Project form, on the tabs on the Financial Term tab, the Remove
actions now properly deassociate the Cash Flow Line Items that are
selected/removed by the user. (Tri-36818)
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Real Estate

Standard Capital Project Cost Codes are no longer available for selection on
the Cost Code section of the Space Use Agreement form. (Tri-13168)

Real Estate

The Accrual Adjustment Amount field and the Credited Amount field on the
Payment Adjustment form are now marked as required fields. (Tri-11751)

Real Estate Lease

The RE Lease is no longer automatically approved if it has been revised and
resubmitted when the Contract Administrator Manual Approver is different
from the person who created the RE Lease. (Tri-38417)

Real Estate Lease

The status of a Payment Schedule that is added from the Generate Payment
Schedule form changes to Scheduled when the RE Lease is activated.
(Tri-37307)

Real Estate
Transactions

Removed the Add action from the OPEX/CAM Reconciliation navigation
queries. (Tri-32805)

Record Runtime

The value of the Language field on a building record is populated from the
originator’s My Profile record. However, in a hierarchy, a child record
inherits the language value from its immediate parent. (Tri-38614)

Reports

Queries to be removed from the shipping product in the future have
TO_BE_DEPRECATED in the query tag. (Tri-40031)

Reports

Removed the contact role filter from the AR Aging report and for the AR
Aging report for asset lease. (Tri-36392)

Request Central

Corrected the workflow that fires when the user selects an Add Space
request or a Return Space request and switches from Me to Someone Else.
(Tri-34015)

Request Central

Improved the columns displayed in the My Call Records portal section when a
user signs in as a Call Center Agent. (Tri-32044)

Request Central

When a move request is completed, the Primary Location field is now
updated on the My Profile forms of affected users. (Tri-35612)

Requests > Add
Person

Added a Location field to the New Hire Details section on the Add Person
Request. (Tri-39105)

Requests > Contact
Center

The Follow Up task notification is now only sent to the "Associated To"
person if the agent has multiple My Profile associations. (Tri-36847)

Requests > Contact
Center

When the user navigates down the solution tree and selects the solution
instruction, the correct solution is created and appended to the Solution
section of Contract Center. (Tri-22851)

Requests > Manage
Requests

On the Human Resources, New Hire form, the Add Person radio button in the
Service Request section now works properly. (Tri-36536)

Requests > Manage

The as-shipped Vehicle Specification Class no longer includes the following
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Reservations

specification classes: LMV and HMV. (Tri-38023)

Requests > My
Requests

On a New Hire request, when the user selects the Someone Else check box
and the Requested For is a person with a building that has manage service,
only Add Person is prepopulated. (Tri-39683)

Requests > My
Requests

Resolved an issue in the translation into some languages with the way
navigation items that show in a Reminders section are labeled. Now the
labels are reordered using the format # - Label. This change applies to all
navigation items in Reminders sections that can be found on landing pages or
home portals. (Tri-36721)

Requests > My
Requests

The Copy action on a Move Request Line Item record now copies the Move
Planner from the From Location section to the copied record. (Tri-36899)

Requests > Survey

Survey questions from the selected template on a General Evaluation
Request are now displayed on the General Evaluation Survey record.
(Tri-39419)

Security Groups

TRIRIGA Application Administrator and TRIRIGA Environmental
Manager/Planner now have access to the Environmental Meter Log.
(Tri-38272)

Setup > Classification
Manager

Some classification records do not have the correct status record association.
You use the patch helper workflow triPatchHelper - triCalculate 10.3 - Fix All Classification Status Field to resolve.
(Tri-20417)

Space > Find Space

The Find Space feature for People, Space, and Asset now prompts users to
enter search criteria before the search is processed. This targeted search
returns results to the user more quickly. (Tri-38510)

Space > Plan Moves
(Move Designer)

Move Service Request now shows the To Location once the individual move is
set. (Tri-34556)

Space > Plan Space

Entering a Target Value for the SFP - OPS - Time to Complete (Months) on
the Planning Goal Item form no longer causes an error. (Tri-39940)

Space > Space Plan

When the user clicks Move Facilities Project - Upload Error in the Related
Reports, they now see the Related Reports for Move Facilities Projects.
(Tri-36285)

Space Use
Agreements

Cost Code subqueries on the Find action of the Cost Code section in a Space
Use Agreement record now appear as subreports of each other so that
selecting one will display the others in the subqueries list. (Tri-13049)

Specification

Specification forms now display the Attention section on the System tab.
(Tri-32409)

Specifications >
Consumables

Revised the workflow that tests for a null value in the user message. The
affected workflow is triConsumablesSpec - triUploadHidden Validate Data. (Tri-32132)
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State Family Manager

RFP Response state family for create, save, save and close now map the
correct workflows. (Tri-32333)

Sustainability >
Certifications

Added a Revise action on the Energy Rating Schedule. This action removes
scheduled events, which will stop polling on the Energy Rating Schedule.
(Tri-36608)

Sustainability >
Certifications

Resolved an issue slowing performance of the Rating Schedule. (Tri-36599)

Sustainability >
Environmental Data

In Sustainability > Emission Factor > Energy, moved the Energy Source field
to the Details section, made the Energy Source field read only, and populate
the Energy Source field based on the Meter Type. (Tri-37123)

Sustainability >
Environmental Data

The value the Projected Energy field now defaults to be the same as the
value of the Current Energy field in the Carbon Footprint Analysis Summary
section of the Carbon Footprint Analysis form. (Tri-32573)

Sustainability >
Environmental Data

Travel Emission Data now only shows the scope section that is based on the
scope in the travel log. Energy Emission Data now only shows the scope
section that is based on the energy source selected in the travel log.
(Tri-37723)

Sustainability >
Environmental Data

You must retire existing emission factor records for travel, energy, global
warming, and waste before creating new records. (Tri-37514)

Sustainability > Set
Up

The units of measure for CO2, CH4, and N2O emissions are now correctly
displayed in the field label. Previously these were displayed in drop-down
lists even though selecting different units did not change the calculations.
(Tri-37766)

System Manager

Corrected field values in 11 workflows. (Tri-23065)

System Manager

In the Help record, documents selected in the Related Topics section using
the Find action on the Related Documents tab now display. (Tri-13013)

Task Templates

The Find action on the Dependencies section of the task templates listed
below now points to the correct query. The affected task templates are as
follows: Schedule Task Template, Facility Assessment Work Task Template,
Contract Review Template, Inspection Task Template, Inventory Count Work
Task Template. Inventory Pick Work Task Template, Key Work Task
Template, Punchlist Task Template, Reserve Work Task Template, Schedule
Task Template, Submittal Task Template, and Work Task Template.
(Tri-27784)

Tasks

The section label for assigned service provider is now "Responsible
Organization" for the Contract Review, Contract Review Template,
Inspection Task, Inspection Task Template, Punchlist Task, Punchlist Task
Template, Submittal Task, and Submittal Task Template forms. (Tri-13156)

Tasks > Manage Tasks

In the Schedule Task form, when a user inputs a number into the Lead()/Lag(+)Working Days field and the Lead(-)/Lag(+)Working Hours field and
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then saves the record, the Lead(-)/Lag(+)Total Working Hours field is now
calculated correctly. The same update has been applied to the following
tasks: contract review, facility assessment work task, inspection task, key
work task, material order task, punchlist task, reserve work task, schedule
task, submittal task, work task, inventory count work task, and inventory
pick work task. (Tri-36689)

Tasks > Manage Tasks

The triNameTX field in all task business objects now has a length of 150
characters. (Tri-36975)

Tasks > Manage Tasks

When the user clicks the Find action in the Responsible Organization section
of a Work task, the Assign and Auto-Assign actions are hidden and the
Unassign action shows. When the user clicks the Clear action, the Unassign
action is hidden and the Assign and Auto-Assign actions show. This change
was made to the following task types: Work Task, Schedule Task, Inventory
Count Work Task, Inventory Pick Work Task, Key Work Task, Material Order
Task, Punchlist Task, Submittal Task, Inspection Task, Reservation Work
Task, and Facility Assessment Work Task. (Tri-32340)

Tools >
Administration

Active, Review Cancelled, and Template status classification records that
were in retired status have been changed to active status. (Tri-37099)

Tools >
Administration

Added OSCRE ID = 999 to Frequency Type "Specific Quarterly (Location
Specific)" Classification records. (Tri-37143)

Tools >
Administration

Added yyyy/MM/dd HH:mm zzz, dd.MM.yyyy HH:mm:ss, and yyyy-MMdd HH.mm to the Date Time Format List. (Tri-36707, Tri-36830)

Tools >
Administration

Carbon Calculation Region Classification (NERC Region) files are no longer
delivered with the application. (Tri-37762)

Tools >
Administration

The Bulk Security Utility now supports bulk updating of License and Security
Group details for multiple users. (Tri-36073)

Tools >
Administration

The copy created as a result of the Copy action on the RE Savings Type
classification record now is created under the parent record instead of under
the root hierarchy. (Tri-37088)

Tools >
Administration

The OSCRE ID field is no longer copied from the original Unit Type
Classification record to the copy record. (Tri-39129)

Tools > Approvals &
Notifications

Resolved issues causing notifications to be sent twice instead of once.
(Tri-37087)

Tools > Builder Tools

A number of queries had reverse association set to yes even though it was
not required. These queries now have reverse association set to no.
(Tri-39388)

Tools > Builder Tools

British English, Korean, and Thai are no longer included as delivered values
in the Language Manager. However, if you are doing an upgrade to 10.3 using
the object migration package, you need to remove these entries manually
from triLanguage and Language lists under the triCommon module.
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(Tri-39155)

Tools > System Setup

Corrected an issue that caused the System Job Scheduler to only process the
first carbon log when Capture Historic Runs was checked. Now the Carbon
Calculation Needed flag on buildings is not reset immediately after the
historic capture runs. The processing determination and reset of the check
box now takes place on the subsequent capture that is set for a future date.
(Tri-36186)

Tools > System Setup

GIS maps have been updated with changes from Esri. (Tri-40505)

Tools > System Setup

If a user password fails because it is longer than the maximum password
length set in Tools -> System Setup -> System -> Password Setup, the
message displayed to the user now includes the maximum length. (Tri-34597)

Tools > System Setup

If the values saved in Application Settings, Lease Accounting Settings tab,
Rent Component Assumption Defaults section total more than 100%, the
System tab now shows an appropriate Attention message. (Tri-35801)

Tools > System Setup

Related Reports queries for Transformation Content - Upload Error and
Transformation Content - Review In Progress now return records in the
correct status. (Tri-32711)

Tools > System Setup

Resolved the issue causing the Building Cost ETL to work incorrectly.
(Tri-37375)

Tools > System Setup

The Delete and Copy actions have been removed from the System
Configuration form. (Tri-32713)

Tools > System Setup
> Application
Settings

In 10.3, the currency in the Application Settings defaults to SYSTEM_BASE,
which is the base currency defined in the TRIRIGAWEB.properties file.
The functionality that references this field now can pull in a
currency/number field in currency other than US Dollars; however, existing
data remains as is. You can use the following Patch Helper workflows to
reset the currency/number fields for an existing Application Settings record:
(1) triPatchHelper - Synchronous - Retro Application
Settings Currency UOM, (2) triPatchHelper - triCalculate 10.3 - Retro Application Settings Currency UOM (Tri-37061)

Transaction Plan

CTQs are mapped from the Transaction Plan and the user can request a CTQ
Evaluation. (Tri-36152)

User Profile

The Created Date and Modified Date Time fields on the System tab of a
record now display in the user's date format preference. (Tri-33263)

Work Task

When a work task is completed, if the Actual End Date field is empty, the
field is now populated with the user’s current date and time. If the Actual
End Date field contains a value when a work task is completed, no change is
made to the value. (Tri-27567)

Work Task Template

Materials put under Resources on a Work Task Template are now copied to
the Work Task. (Tri-14122)
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Workflow Builder

Removed an unused workflow, triOption - triExercise - Create
notifications for Renewal type Options. Retiring or deleting this
workflow manually in your environment is optional. (Tri-39183)

Workflows

Removed the End Task from the middle of the triSpace - Synchronous
- Set Availability Dates - Refresh Planned Occupancy and
Planned Vacancy workflow. (Tri-33897)

Workplace
Reservation Manager

A notification has been added to inform the requester on a reservation when
the room was set up for auto-cancellation and the system cancelled the
room. (Tri-75224)

Workplace
Reservation Manager

The Reservation system now supports the ability for a user to end a meeting
early (from the reservation user-interface) so that the room can be freed up
for others to book. (Tri-68980)

Workplace
Reservation Manager

Users can now check out from the reservation user interface, so that the
room can be freed up for others to book. If the user does not check out, the
system automatically checks them out at the planned end time of the
reservation. (Tri-70252)

Workplace
Reservation Manager

You can perform workspace searches based on the functional role
entitlements that are configured on the workspace for the user that is
identified as the requested for. This feature is enabled and disabled in the
Application Settings. (Tri-70097)
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IBM TRIRIGA Application Platform 3.3.1
This chapter details important information, known limitations, changes, and property file changes for
the IBM TRIRIGA Application Platform.

Important Information
Important information concerning the IBM TRIRIGA Application Platform for this release includes the
following:
Area of Impact

Description

Branding

If you are upgrading from a version of IBM TRIRIGA Application Platform prior
to 3.0, due to significant changes in the portal, IBM TRIRIGA does not map
previous branding styles to the new style classes in the Style Manager. The
upgrade to IBM TRIRIGA Application Platform 3.x preserves header details,
but you need to rebrand the rest of the page. Find the Style Manager in the
Utilities portal section or by selecting Tools > Administration. The Style
Manager is described in the IBM TRIRIGA Application Platform 3 User
Experience User Guide.

Browsers

Browser

Important Information

Apple Safari



The following builder tools are not supported:
Classifications, Lists, Data Modeler, Form Builder,
Association Manager, Workflow Builder, Portal
Builder, Navigation Builder, State Family Manager,
Scorecard Manager, License Manager, Security
Manager, Data Integrator, Object Migration,
Currency Conversions, Label Manager, and Style
Manager.



Brava viewer is not supported in the Document
Manager. (Tri-81601)



Excel sections are not supported.



Safari does not support dragging and dropping files
from the finder into the multi-file uploader in the
Document Manager. (Tri-80867)



There is limited support for HTML5 charts.



Users on a Mac OS X must use the Shift key when
resizing section and field lookup dialogs.
(Tri-82179)



The following builder tools are not supported:
Classifications, Lists, Data Modeler, Form Builder,
Association Manager, Workflow Builder, Portal

Google Chrome
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Builder, Navigation Builder, State Family Manager,
Scorecard Manager, License Manager, Security
Manager, Data Integrator, Object Migration,
Currency Conversions, Label Manager, and Style
Manager.

Internet Explorer
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Excel sections are not supported.



Java applets are not supported for Chrome on Mac
OS X.



There is limited support for HTML5 charts.



For BIRT printing to PDF, use the Chrome PDF
viewer instead of the Adobe pdf plugin. For more
information, use your browser to search for How
To Enable the Built-in PDF Viewer in Google
Chrome. (Tri-67281)



If your locator field drop-downs and navigation
menu drop-downs are hidden behind applets like
stacking, availability, and Gantt sections, minimize
the applet section and reopen it when you need it
again. (Tri-66901, Tri-71492)



Microsoft Internet Explorer (IE) 8 includes a
“Preserve Favorites website data” option. This
property is selected (on) by default in IE 8. This
property retains temporary Internet files from sites
that are in your Favorites even if you have set the
flag to delete all temporary files. Clear this
property. If left on and a user’s IBM TRIRIGA server
is in their Favorites, the cache is not cleared,
which can cause js, jsp, and style sheet issues
after an upgrade. If you want to clear your cache,
uncheck the “Preserve Favorites website data”
option.



Due to a known limitation in IE 10, the background
color on fields may show when the record is
printed from the print preview page. (Tri-75848)



In IE 10, Classifications, Lists, Data Modeler, Form
Builder, Association Manager, Workflow Builder,
Portal Builder, Navigation Builder, State Family
Manager, Scorecard Manager, License Manager,
Security Manager, Data Integrator, Object
Migration, Currency Conversions, Label Manager,
and Style Manager are not supported.



In IE 10, Excel sections are not supported.



Query sections do not display correctly if the
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browser zoom is set to a custom value that is less
than 100%. The default browser zoom is 100%.
(Tri-33883)

Mozilla Firefox
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Some builder tools do not load or work correctly if
the browser zoom is set to a custom value that is
less than 100%. The default browser zoom is 100%.
(Tri-28866)



When a user exports a PDF file from a graphics
section, IE may display a security message in the
browser window. To prevent this security message
from displaying, add the IBM TRIRIGA application
URL to IE’s Internet Security list of Trusted Sites
zone. In the Security Settings for Trusted Sites
Zone, set the Download permission to not display
the warning message. (Tri-31024)



When a user running IE 8 with "Smart Screen
Filters" turned ON tries to load more than 1000
records on a page, IE 8 verifies the response it is
getting back and crashes, since the response is too
large. To avoid this circumstance, turn off the
"Smart Screen Filters". For more information refer
to
http://www.microsoft.com/security/filters/smarts
creen.aspx (Tri-27698)



Your browser must not use a compatibility view. To
confirm that your browser is not in a compatibility
view, press the F12 key, click the Browser Mode
tab, and then select the setting for your browser.



The following builder tools are not supported:
Classifications, Lists, Data Modeler, Form Builder,
Association Manager, Workflow Builder, Portal
Builder, Navigation Builder, State Family Manager,
Scorecard Manager, License Manager, Security
Manager, Data Integrator, Object Migration,
Currency Conversions, Label Manager, and Style
Manager.



Excel sections are not supported.



Fixed column queries do not remain fixed due to a
Firefox limitation.



Opening a new record in the popup view opens the
new window behind the window that originated it.
This is a known issue with Firefox / Adobe Flash.
Disabling the plug-in fixes the issue. You can find
more information in the following article:
http://support.mozilla.org/en-
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US/questions/938033 (Tri-78853)


There is limited support for HTML5 charts.



Firefox may not close all windows automatically
when signing out of a single sign-on session.
(Tri-84899)

Duplicate Portal
Sections

IBM TRIRIGA Application Platform 3.x does not allow duplicate portal section
names. The upgrade process from IBM TRIRIGA Application Platform versions
prior to 3.0 updates the first portal section found and logs information about
subsequent portal sections with the same name in the portalupgrade.log
located in the install root.

Duplicate Portals

IBM TRIRIGA Application Platform 3.x does not allow duplicate portal names.
The upgrade process from IBM TRIRIGA Application Platform versions prior to
3.0 renames any portal with a duplicate name by attaching a sequence
number to the end of the duplicated name. For example, the second portal
named “Employee Portal” becomes “Employee Portal1” and the third
becomes “Employee Portal2”.

Graphics



Exporting very large graphics could require configuring your web server
with a larger maximum post size. (Tri-28770)



Exporting from a graphics section does not work properly on WebSphere
with SSL. By default, WebSphere adds additional caching headers to
responses that already contain cache control, which causes issues in IE
when trying to stream application data like PDF files back to the client.
This can be disabled via a custom property for your application server in
the WebSphere Integrated Solutions Console. Note that this change
merely prevents WebSphere from automatically adding headers; you are
then left with the cache control headers that IBM TRIRIGA intends to be
there. Please reference the following guide:
http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic
=%2Fcom.ibm.websphere.express.doc%2Finfo%2Fexp%2Fae%2Frrun_chain
_httpcustom.html
Following the steps in that guide, add a custom property named
CookiesConfigureNoCache with a value of False to your secure
HTTP transport channels.
Once completed, restart the server, and the Export works properly.
(Tri-34664)

Installation

Choose the same application server type as the installation you are
upgrading from when you perform an upgrade installation. (Tri-89356)

Microsoft Excel

The Office Web Components (OWC) library that IBM TRIRIGA uses for Excel
sections is not available in a clean install of Office 2007 or Office 2010. For
information about downloading the OWC library and installing it as a
separate component, search for office web components roadmap on the
Microsoft website http://blogs.office.com. You do not need to download and
install the OWC library if you upgrade Office 2000 or Office 2003 to Office
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2007 or Office 2010, because the OWC library is available.

Microsoft SQL Server



For a Microsoft SQL Server (MSSQL) database, running the Multi-Byte
Character Support (MBCS) conversion process during upgrade to 3.3 can
take several hours. The duration depends on many factors, such as
hardware, database size, and disk speed. (Tri-32051)



If the upgrade of an MSSQL database with MBCS enabled fails and you see
in the ant.log that there were invalid views during the NVarchar
Conversion process, use the following recovery steps:
1. Review the ant.log to identify the invalid views.
2. Run the upgrade with MBCS Support turned off.
3. Log into IBM TRIRIGA and republish the business objects identified in
the ant.log as having invalid views.
4. Run upgrade with MBCS Support turned on. (Tri-32284)



If you are upgrading an MSSQL database with MBCS enabled, prior to the
upgrade to 3.3 you must (1) back up your database, and (2) republish the
triRealEstateContract business object in the triContract
module (10.x, 9.x). This is to avoid a possible MSSQL error on the backing
table of that business object during the upgrade. The error that might
occur if the business object is not republished is as follows: "Cannot
create a row of size xxxx which is greater than the allowable maximum
row size of 8060". If this error occurs, the table is not configured
correctly for MBCS. In this case, restore the database and contact the
IBM TRIRIGA team at IBM Software Support for additional instructions.
(Tri-31926)



If you have custom tables in the IBM TRIRIGA table space and you are
upgrading to MBCS on Microsoft SQL Server, these tables may not convert
correctly depending on the table definition (for example, if
IDENTITY_INSERT is set). These tables need to be either deleted or
converted manually prior to running the 3.3 MBCS upgrade.
To convert these tables manually, alter all varchar fields to be
nvarchar and alter their collation to the collation used during the
conversion during install. For example, for field XXX in table YYY when
your desired collation is Japanese_CS_AS and the SIZE of the varchar
field is 100, the script is as follows: alter table YYY alter
column XXX nvarchar(100) collate Japanese_CS_AS
(Tri-32702)



Navigation

Microsoft SQL Server has a row size limit of 8060 bytes. On MSS2005 and
MSS2008, there is an overflow mechanism that transparently enables a
row to logically exceed 8060 bytes while physically overflowing some of
the extra data into a separate part of the database. More information
about the 8060 byte limit can be found at the following link:
http://msdn2.microsoft.com/en-us/library/ms186981.aspx.

Pressing a key or key chord and the Access Key character navigates the user
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directly to the tab or triggers the action defined in the Form Builder.
Different browsers use different keys or key chords, as follows:

Object Migration

Oracle



For Microsoft Internet Explorer -> Alt+AccessKey+Enter



For Mozilla Firefox -> Alt+Shift+AccessKey



For Google Chrome -> Alt+AccessKey



For Apple Safari -> Alt+Control+AccessKey (Tri-71056)



Some object types in object migration packages from a pre-3.0
environment do not import into a 3.x environment. The object types that
do not import into 3.x are as follows: managers; pre-3.0 portals; pre-3.0
scorecards; and shortcut list, quick add list, query list, and action items
query portal sections.



When an object migration package created before IBM TRIRIGA
Application Platform 3.3 is imported into an environment that has been
upgraded to IBM TRIRIGA Application Platform 3.3 and IBM TRIRIGA 10.3,
the language table is deleted. This is because the localizable property
does not exist in an object migration package created prior to IBM
TRIRIGA Application Platform 3.3. As a result the localizable property
value that is already in the target system is reset. By design, the business
object publish deletes the column for a field that is no longer marked as
localizable. Since an old object migration package does not have this
property, all the columns are dropped, which eventually drops the entire
language table.



If you are installing a new Oracle database and wish to support multibyte characters, make sure your instance character set is UTF-8 or UTF16 and your NLS_LENGTH_SEMANTICS is set to CHAR, not BYTE. Follow
the instructions in the IBM TRIRIGA Application Platform 3 Information
Center under Installing IBM TRIRIGA Application Platform to ensure your
platform supports multi-byte characters properly. (Tri-32998)



If you are upgrading an Oracle database and are considering changing the
instance character set to UTF-8 or UTF-16 to support multi-byte
characters, it is imperative that you carefully follow the instructions in
the IBM TRIRIGA Application Platform 3 Information Center under
Installing IBM TRIRIGA Application Platform. Failure to do so could
compromise your data.

Report Manager

Reports with blank titles show up first in the list if the database is Microsoft
SQL Server and show up last in the list if the database is Oracle.

Security



You can find instructions for managing issues with applets such as Gantt
where the applet console reports a security exception under CVE-20103560 at
http://www.oracle.com/technetwork/java/javase/6u22releasenotes176121.html.



Security is not applied when a PDF generated from an external report
type (BIRT and Crystal) is emailed. (Tri-88536)
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Software Licenses

Starting with IBM TRIRIGA Application Platform 3.2, IBM TRIRIGA distributes
software licenses in a separate license file for each product. The license file
names are in the format
LICENSE_IBM_TRIRIGA_{productname}.properties (for example,
LICENSE_IBM_TRIRIGA_Application_Platform.properties).
You may continue to use your existing TRIRIGALICENSE.properties file
if you have one. You do not need to replace your
TRIRIGALICENSE.properties file until it expires or your software
requirements change.
At the end of an install, your config\licenses directory should contain
either your LICENSE_IBM_TRIRIGA_{productname}.properties files
or your TRIRIGALICENSE.properties file, but not both.
After you start using the
LICENSE_IBM_TRIRIGA_{productname}.properties files, do not
revert to the TRIRIGALICENSE.properties file. (Tri-33449)



Attention – All application servers accessing a database must
have the same license set. The only exception is the license for
IBM TRIRIGA Connector for Business Applications since it may be
licensed only on a limited number of servers and should only be
placed on that number of servers to stay in compliance.

Syclo

Syclo has been removed from the IBM TRIRIGA Application Platform 3.3.1
Compatibility Matrix. Customers should contact the vendor with any issues
or concerns regarding Syclo and version 3.3.1.

System Configuration

IBM TRIRIGA Application Platform 3.2 can consume more resources than
previous releases. Monitor database connections and memory consumption,
increasing values if needed.

WebSphere



The automated installation of TRIRIGA with WebSphere may fail if the
com.ibm.SOAP.requestTimeout parameter value is not increased.
The parameter can be found in the soap.client.props file within the
Application Server properties directory of WebSphere. Setting this value
to 0 makes it unlimited.



When using WebSphere, an additional MIME Type is required for certain
pages in the application to display properly. You must add a new
extension, phtml, as text/html. For more information, go to the IBM
TRIRIGA Application Platform 3 Information Center and select Installing
IBM TRIRIGA Application Platform. (Tri-29060)



Use the correct JDK for your WebSphere installation.
If you have two WebSphere installations,
one at
/[pathToWebsphere]/IBM/WebSphere/AppServer for
WebSphere 8.0
and one at
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/[pathToWebsphere]/IBM/WebSphere/AppServer85 for
WebSphere 8.5
using java in the 8.0 installation causes the installation to fail.
(Tri-89328)

Known Limitations
Known limitations concerning the IBM TRIRIGA Application Platform for this release include the
following:
Area of Impact

Description

Document
Management

Double-byte characters do not display when you preview Unicode or UTF-8
txt files. You must download the file to see the content. (Tri-36352)

Extract, Transform,
and Load (ETL)



The as-shipped ETL scripts are written against the standard IBM TRIRIGA
database and its database columns, but after an upgrade, a small number
of your implementation’s database column names that were autogenerated during the upgrade may be slightly different and not match
the names in the released ETL scripts. Review your ETL scripts and
change them as needed to ensure the column names match the
generated column names in your database. (Tri-27625, Tri-27705)



If you use any of the IBM TRIRIGA Workplace Performance Management
products, any of the IBM TRIRIGA Real Estate Environmental
Sustainability products, the OSCRE features, or ETL Job Items, the name
of your IBM TRIRIGA installation directory and the location of the
application server cannot contain spaces. These applications use Pentaho
to run ETLs. Pentaho is a third-party application that has a startup issue
when the name of the directory where the application resides has a
space in it. For more information, see the Pentaho issue database for PDI
2689 at http://jira.pentaho.com/browse/PDI-2689.

Gantt

In SSO environments, the Gantt section applet only supports Basic
Authentication. (Tri-84737)

GIS Maps

The as-delivered sample editor widget and overview widget sometimes do
not display when the user clears the browser cache and opens the map.
Refresh the map and the widgets show properly. (Tri-81522)

Globalization

Formulas involving a localized field may only calculate the language values
(L_ table) of the current user in session. For example, a localized text field
is used in a formula to concatenate with another field value. The calculation
of the language value of the localized text field is based on the language of
the current user in session. The other language values available of the
localized text field, if any, are not included in the calculation of the
formula. For example, an Italian user triggers a calculation of this
concatenation formula. The Italian language value is concatenated and the
Italian user can see that the calculated value has the concatenated Italian
language value. However, other users only see the default internal values
(T_ table) calculated in the formula even if there are, for instance, German
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or Chinese language values available for the localized text field.
Similarly, formulas that are processed by the extended formula queue do not
use the language values in the calculation. The extended formula process
only uses the internal values of the localized field in the calculation.

Globalization

The following areas are not fully globalized and translated:






Application builder pages are only available in US English, including Form
Builder, Data Modeler, and Workflow Builder.
The installer is only available in US English. Installing to a path under
Program Files may not work on a non-English version of Windows.
Some pages to which only an administrative user has access are only
available in US English. This includes Application Setup pages, the
Administrator Console, and data utilities.
Brava! Viewer labels are available in US English only.
Document paths in BIRT reports are available in US English only.

IBM TRIRIGA
Connector for Offline
Forms

Microsoft Exchange converts a sent Microsoft Outlook message (.msg file) and
any attached messages (.msg files) into Multipurpose Internet Mail Extensions
(MIME) format. However, the IBM TRIRIGA Incoming Mail Agent is not
designed to recognize attachments in MIME format. Instead of attaching
Microsoft Outlook .msg messages to another .msg message, you have two
options. To attach the file, either (1) From Microsoft Outlook, save the .msg
attachment as a Microsoft Outlook file template (.oft file). Then, attach the
.oft file to the main .msg message that you are delivering in Microsoft
Outlook, or (2) From Microsoft Outlook Web App (OWA), attach the .msg file
to the main email that you are delivering, in the OWA. After attaching the
file, send the message or email. (Tri-67117)

IBM TRIRIGA SVG
Viewer

The IBM TRIRIGA SVG Viewer is not well suited for design-time work and not
supported for working on very large workflows. Use the Adobe SVG Viewer
Plug-In for design-time work. (Tri-20731)

Language Packs



When you import a language pack for the first time, you may see
exception messages in the LabelManager.log file. To eliminate the
exception messages, repeat the import of the language pack.



You may see persistence errors in the Translation.log file when a
language pack is imported into a 3.2 to 3.3 upgrade file with the object
migration package applied. These errors are displayed because the field
that is referenced has been removed from the application. You do not
need to repeat the import of the language pack to fix this issue.

Metric Query

Only the US Dollar symbol is displayed for currency data, regardless of the
user’s UOM preference or of the currency UOM set for a project. (Tri-38270)

Microsoft Exchange

Microsoft Exchange (SMTP) does not support Yearly recurrences when day,
weekday, and weekend day are specified for the weekly option. (Tri-39663)

Single Sign-On

IBM TRIRIGA CAD Integrator/Publisher and Gantt require basic authentication
to be enabled.
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Style Manager

When upgrading to a 3.x platform from 2.7 or earlier, some font styles
remain the same while the background changes color, or vice versa. This can
lead to a situation where the background and font color are the same, for
example, white text on a white background on the actions in security groups.
To resolve this issue, apply, or re-apply, the stylesheet.xml supplied
with the new platform install. The style sheet can be found in the
userfiles/skin directory on your IBM TRIRIGA application or process
server. Copy the file to your local workstation, login to IBM TRIRIGA as a user
that has admin access, navigate to the Style Manager in the Builder Tools or
Administration menu, and import stylesheet.xml. NOTE: This process
resets all colors on your system. Use the Style Manager to reset the main
colors for your installation. Reapplying the default style sheet eliminates any
strange color combinations in the updated architecture and provides a basis
to start anew with themeing your system. (Tri-39080)

IBM TRIRIGA Application Platform 3.3.1 Changes
Area of Change

Description

Accessibility

As-delivered portal images now include an alt attribute to conform to the
Deque screen reader standard. (Tri-71578, Tri-71584)

Administrator
Console

A history of the patches applied to your system can be viewed in the Build
Number page of the Administrator Console. (Tri-70308)

Application Security

Users who do not have access to a portal page now see a no access message.
(Tri-83714)

Application Server

The automated WebSphere install now includes the following Java option to
support environments where BIRT reporting is on a separate server:
-Xjit:exclude={org/mozilla/javascript/UintMap.rehashTable*}
To add this Java option manually:
1. Open the WebSphere Console on the server.
2. Navigate to Servers > Server Types > WebSphere Application servers >
serverX > Java and Process Management > Process definition > Java
Virtual Machine
3. In the Generic JVM arguments section, add
Xjit:exclude={org/mozilla/javascript/UintMap.rehashTable*}
4. Bounce the application server. (Tri-70391)

Cleanup Agent

The Cleanup Agent no longer puts messages in the server log when Crystal is
not installed. (Tri-77293-IV37383)

Currency Conversion

Currency conversion pages now show the value of the currency conversion rate
field in standard decimal format instead of in exponential number format.
(Tri-66913)
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Data Integrator

A user that is not a member of the Admin Group no longer receives a security
error message after uploading a file to Data Integrator. (Tri-66639-IV31704)

Data Modeler

A state transition action now honors the value of the Audit Actions property of
a business object. For a state action to be audited, the Audit Actions flag must
be selected. (Tri-67115-IV29894)

Data Modeler

Changed the Sub Action property label from "Log" to "Audit Action". (Tri-66914)

Data Modeler

If the business object is in a published state, you can now highlight the field
name of a field label in the business object field list. (Tri-76826)

Data Modeler

Resolved an issue where searching for a field with an invalid character in the
label (as specified in TRIRIGAWEB.properties) in the Data Modeler caused
a system error. (Tri-81064)

Data Modeler

Text fields now support a field size of up to 1000 in Microsoft SQL Server
implementations. (Tri-81012)

Data Modeler

The default layout is now business object/field properties first, field list
second, and associations third. All are full height by default. (Tri-66640)

Data Modeler

Where Used for fields now includes when the field is used in a workflow
variable from an expression. (Tri-70305)

DataConnect

A DataConnect upsert on a business object that has no DataConnect keys
defined now performs an insert of the data in the staging table record.
(Tri-87523)

Document Manager

The referenced files of a document in publication are also published when the
"Include Referenced Documents" option of the publication is checked.
(Tri-67065)

Documentation

The IBM TRIRIGA 10 Document Management User Guide now correctly reflects
the actions available after selecting the Publish action. (Tri-68789-IV34260)

Esri GIS

It is only necessary for a user to add either the city and state or the zip code
in the address section of a building record for the geocode address to find the
building. (Tri-66462)

Esri GIS

Removed the Move Location feature. (Tri-79574-IV37847)

Formula Engine

A server no longer fails on startup if an extended formula has a bad UOM_TYPE
on one of its fields. (Tri-66659)

Gantt

Gantt form sections can now be set to read only from a Modify Metadata
workflow task. (Tri-88361-IV40957)

General

Resolved an issue where moving elements in AutoCAD was causing AutoCAD to
crash. (Tri-80872)
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GIS

If you load a GIS tab or portal section and see the following phrase: "No
EsriJS_arcgis.js file found.", it means that you need to go to esri.com and
retrieve the
http://serverapi.arcgisonline.com/jsapi/arcgis/3.3/ file, name
it "EsriJS_arcgis.js" and upload it to the EsriJS Classloader object under System
> ClassLoader > EsriJS > Resource File. (Tri-89664)

Globalization

A note has been added for IBM translators when a particular label should be
partially (or not completely) translated. (Tri-88152-IV40891)

Globalization

Changed the sequence of the words in the tooltip for Portfolio > Key Rings >
Inline View > Add so that it can be translated into German and Korean.
(Tri-78492)

Globalization

Label Manager now supports import and export in US English. (Tri-83917)

Globalization

Offline content labels with line breaks are now translated. (Tri-66902)

Globalization

Opening a record when there is no UOM for a particular language no longer
causes an error for a non-US English-language user. (Tri-78496)

Globalization

Resolved an issue that caused an error when a non-US English-language user
viewed the Reports tab in a record. (Tri-87881, Tri-87939-IV40668)

Globalization

Resolved an issue that prevented the XLIFF export format from retaining
existing translations when a language is selected. (Tri-71052)

Globalization

The welcome string is now exported as "Welcome, {0}" so that the welcome
string can be set with the user's name before or after the welcome.
(Tri-80876)

Installer

JBoss EAP 5.1.0 is now supported in the installer. For more information, go to
the IBM TRIRIGA Application Platform 3 Information Center and select
Installing IBM TRIRIGA Application Platform. (Tri-66488)

Installer

WebLogic 11 Rel 1 (Version 10.3.6) is now supported. (Tri-86782)

Instance Data
Globalization

Classification query now filters data correctly when a non-US English value is
entered as the filter value. (Tri-88257-IV40876)

Instance Data
Globalization

The instance data language pack can be imported successfully when the host
name or IP of the application server is listed in the trusted websites of the IE
browser. (Tri-79570-IV38476)

Instance Data
Globalization

When there are no fields with the localizable flag set in all of the business
objects in a module, now the localized views (ML_ and VL_ view) are dropped
along with the language table. (Tri-69712)

Instance Data
Translations

Setting a value to a locator field from an editable query is now properly
setting the translated values. (Tri-87878-IV40666)
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Integration Object

When you import instance records for the TRIRIGA Integration Object, run the
patch helper named IntegrationObject_DataMaps. This patch helper
triggers a utility that scans the current data maps and correctly reassigns the
object IDs that are needed to save records. (Tri-74041)

Label Manager

An entry is made to the environment_properties table when a language
pack is imported using the Label Manager. (Tri-66694)

Label Manager

Custom tooltips configured in the Label Manager now display the appropriate
custom values when viewed in records. (Tri-66393)

Label Manager

Double byte characters now display correctly in label tooltips. (Tri-84117)

Label Tooltips

The correct tooltip translation is now provided on a form with fields with the
same name but that are from different business objects. (Tri-84735)

Label Translations

“Processing Excel Sections." is now translated when a user clicks the Calculate
Data action on an Excel section. (Tri-67121)

Label Translations

When a form is copied, the existing translations are also copied to the new
form. (Tri-80443)

License and Security

Security groups and licenses are now checked on scorecard queries and subqueries. The query is not shown on the scorecard if the user does not have
access to the module and business object of the query. (Tri-66696)

License and Security

When a system includes a license for IBM TRIRIGA Workplace Reservation
Manager, a user that does not have any assigned licenses can access
notifications and action items. (Tri-76307)

Metric Reports

Metric query tabular reports no longer fail when the user clicks to see the next
set of results at runtime when no order column and related reports are
specified in the report design. (Tri-76800)

Metric Reports

Metric reports now show the date in the hover over instead of milliseconds or
spec id. (Tri-66907)

Metric Reports

Metric reports shown by Calendar Week now display data for all weeks within
the given scope. (Tri-66908)

My Reports

When viewing the tabular information backing a chart, if an Associated Field is
selected on the tabular report, the headers of the columns now align properly.
(Tri-72945)

Object Migration

Object migration validation warnings for form data fields that are
Organization, Location, or Geography are no longer shown. These warnings
were invalid as these fields are known to the system. (Tri-75211)

Object Migration

Resolved an issue for business object prefix and suffix mapping with constants
so they import correctly using object migration. (Tri-74668-IV36650)
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Object Migration

Resolved an issue where dependent list values were not being imported in
object migration when they had the same child values but different parent
values. (Tri-90360)

Object Migration

Starts With query filters are no longer changed to Contains query filters in an
object migration import. (Tri-66705-IV31575)

Object Migration

The form property flag "Allow bookmark to specific record" is now migrated
correctly. (Tri-80210)

Portal

All portal sections that display buttons are now 508 compliant, for example,
collapse/expand, maximize/resize, drop downs, and more. (Tri-71591)

Portal Builder

When selected, the new Auto Resize property in a portal section of type
External adjusts the height of the portal section to match the height of its
contents. (Tri-67105)

Portal Sections

Resolved the issue causing the date shown in the Notifications portal section
to not match the date in the Notification record and other places in the
application. (Tri-83548-IV39025)

Portal Sections

The Actions Items dialog from the portal now matches the hours in the Actions
Items dialog. (Tri-67142)

Portals

Items within Quick Links portal sections can now be opened in a new window
by clicking the square blue icon next to the item name. (Tri-75639)

Project Security

To resolve an issue that allowed a user with read-only project security to
update a form, added logic to project security to validate the user’s project
level access before rendering a form. Both of the following properties in
TRIRIGAWEB.properties must be set to Y for project security:
USE_PROJECT_SECURITY and RECORD_PROJECT_CONTAINMENT. (Tri-76952IV37811)

Project Security

When a project’s security is modified, all application server security caches in
a multi-application server environment are cleared. (Tri-82240)

Query and Reporting

Filters on fields of type Date and Time now filter correctly when the user
inputs a date. (Tri-66918-IV33185)

Query and Reporting

Now there are date filters for the Created DateTime system read-only field
query filters. (Tri-85977)

Query and Reporting

PDFs are now created for Form reports attached to a notification email. (Tri66917-IV33312)

Query and Reporting

Resolved a metric query tabular report issue where clicking Next to see the
next set of results caused an error when the primary grouping field was a
locator. (Tri-66904)

Query and Reporting

Resolved an issue where sum columns in a query of type Hierarchy were not
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lined up correctly when a group by was set. (Tri-70693-IV36327)

Query and Reporting

Resolved an issue with exporting a report to Excel where the data in the Excel
columns was not lining up correctly with the Excel headers. (Tri-90285IV42716)

Query and Reporting

Rounded number values now display the same at record runtime and query
runtime. (Tri-74988)

Record Runtime

Modify Metadata now updates the Read Only property for a Form Action
properly. (Tri-87999-IV40877)

Record Runtime

Number fields with a percent sign in the display mask now accept numbers and
persist values. (Tri-70966)

Record Runtime

Resolved an issue caused when the time zone on the user’s computer was
earlier than the time zone on the server; for example, when the user was in
GMT -8 and the server was in GMT -3. (Tri-84640)

Record Runtime

Resolved an issue for validating number fields that contain letters followed by
numbers. (Tri-84729)

Record Runtime

Resolved an issue where hierarchical records opened in a new window would
not close when Save and Close was clicked when the main TRIRIGA window
was changed. (Tri-71639-IV36324)

Record Runtime

Section or record read-only property now updates the Read Only property for a
form action. (Tri-88531)

Record Runtime

The border color and width properties of a section are now properly rendered
in the form. (Tri-72864)

Record Runtime

There were changes to the styling to make the look and feel consistent among
the supported browsers. If you want to make the label text font look like the
way it was in prior releases, you need to increase the labelStyleClass1 font
size from 10 to 12. (Tri-76300)

Record Runtime

When a user clicks Help and a help message does not exist for the record, the
user now sees the default help message instead of a warning message.
(Tri-75323)

Reporting

Resolved an issue in which a non-US English-language user was not able to
export a query result. (Tri-67104-IV32866)

Reporting

Resolved an issue that caused tabular metric reports used for drill through to
show data and records for all forms in the selected business object even
though a filter in the record form field filtered out some forms. (Tri-67299)

Reporting

Tabular metric reports used for drill through and metric reports now only
return data and records for the forms in the selected business object in the
report. (Tri-67205)
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Security

A user belonging to security group that is a copy of another security group now
has access to appropriate forms when creating a report in My Reports.
(Tri-76251-IV37073)

Security

The system non-reversible encryption type is now configurable. It can be set in
the IBM TRIRIGA Administrator Console, under System Manager in the System
Encryption type field. If you wish to update to SHA-2 for your non-reversible
password fields, set the value to a valid SHA-2 type such as SHA-256 or SHA512. (Tri-75849)

Style Manager

Padding-Left property can now be set in the Style Sheet Editor. (Tri-76692)

Style Manager

SectionStyle should only be used to style section elements such as background
color, border color, and width. Labels contained inside the section should be
styled using a dedicated style class named 'labelStyle', where attributes
related to fonts, such as font weight, size, and style, can be specified.
(Tri-67199-IV33785)

Style Manager

The border color of a manager can be changed with the Master Detail Frame
Border Color property of the Style Manager. (Tri-66897-IV30720)

Style Manager

The Style Manager now displays RGB hex values for portal and other
components. (Tri-66683)

Style Manager

There were two sets of data and label styles in the system, in the Style Sheet
Editor and in the Style Manager. The Style Sheet Editor used the same field
styles as the Form Builder. The Style Manager now also uses these field styles.
(Tri-66643)

TRIRIGA Integration
Object

You can now export more than 1000 records. (Tri-81320)

Web Graphics

Lines are now scaled properly in CAD drawings in meters in TRIRIGA web
graphics. (Tri-83546-IV39495)

Web Graphics

The Layer column of the Layer manager on the Web Graphics section can now
be expanded to show the full layer name. (Tri-66178-IV33536)

Web Graphics

The leading zeros in text field values are no longer truncated when displayed
in a graphic report legend. (Tri-75844-IV36881)

Workflow

Resolved an issue with Date fields with decimal values in a Microsoft SQL
Server environment. (Tri-70302-IV36356)

Workflow Builder

Resolved an issue where the label of a task name can be highlighted when a
workflow is in published state in workflow builder. (Tri-77001)

Workplace
Reservation Manager

Resolved an issue that caused incorrect availability for a resource in the
following circumstances: The resource had 24-hour availability and the event
fell in a specific time range after the change to daylight saving time.
(Tri-68259)
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Area of Change

Description

Workplace
Reservation Manager

The Options screen in the Outlook Add-In is now fully translated. (Tri-67124)

Workplace
Reservation Manager

When a Reserve notification emails with an iCal attachment, the body of the
iCal now contains the content of the body of the notification. (Tri-68962)

IBM TRIRIGA Application Platform 3.3.1 Properties
Files
This section describes changes to the TRIRIGAWEB.properties file. For more information, go to the
IBM TRIRIGA Application Platform 3 Information Center and select Installing IBM TRIRIGA Application
Platform > Configuring the platform > Properties files.
Area of Change

Description

AUTO_PROJECT_ASS
OCIATION_RESTRIC
TION

In a new installation, the default value of the
AUTO_PROJECT_ASSOCIATION_RESTRICTION property is now Contains.
(Tri-78601)

CHART_RENDERING_
TYPE

Determines how charts are rendered in the web browser.

COMPANY_FILE_UPL
OAD_EXCLUDE_EXTE
NSIONS

Restricts file uploads of image files according to their file extensions.

COMPANY_FILE_UPL
OAD_INCLUDE_EXTE
NSIONS

Restricts file uploads of image files according to their file extensions.

IMPORT_CONTENT_E
XCLUDE_EXTENSION
S

Restricts file uploads of binary files according to their file extensions

IMPORT_CONTENT_I
NCLUDE_EXTENSION
S

Restricts file uploads of binary files according to their file extensions

OOTB_G11N_EXPORT
_APP_VERSION

Inserts a value or description of the IBM TRIRIGA application version in the
file header of the instance data export. For example, 10.3.1.

SESSION_WARNING_
ENABLED

Allows an alert message to be displayed to a user whose session is about to
expire.

SESSION_WARNING_
THRESHOLD

If the value of the SESSION_WARNING_ENABLED property is set to Y, then
sets the number of minutes the alert message is displayed before the session
is set to expire.

WS_RELIABLE_MESS

Enables (Y) or disables (N) the Web Services Reliable Messaging Protocol
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Area of Change

Description

AGING

(http://schemas.xmlsoap.org/ws/2005/02/rm/).

WS_RM_ACKNOWLEDG
MENT_INTERVAL

The number of milliseconds at which the Reliable Message destination sends
asynchronous acknowledgements. This property applies only when the
WS_RELIABLE_MESSAGING property is enabled.

WS_RM_BASE_RETRA
NSMISSION_INTERV
AL

The number of milliseconds at which an acknowledgement is received by the
Reliable Message source for a given message. This property applies only when
the WS_RELIABLE_MESSAGING property is enabled.

WS_RM_DELIVERY_A
SSURANCE_IN_ORDE
R

Enables (Y) or disables (N) the delivery assurance "in order" type of the
Reliable Message. This "in order" assurance type can be combined with the
delivery assurance type that is specified by the
WS_RM_DELIVERY_ASSURANCE_TYPE property.

WS_RM_DELIVERY_A
SSURANCE_TYPE

The delivery assurance type of the Reliable Message. This property applies
only when the WS_RELIABLE_MESSAGING property is enabled.

WS_RM_INACTIVITY
_TIMEOUT

The number of milliseconds that must pass without receiving a message for
the Reliable Message sequence to be considered terminated due to
inactivity. This property applies only when the WS_RELIABLE_MESSAGING
property is enabled.

IBM TRIRIGA Application Platform 3.3.0.1 Changes
This release introduces a new way for you to upgrade your version of the IBM TRIRIGA Application
Platform. The fix pack installer, which is also known as the patch installer, is now available for you to
upgrade in-place.
With this release, the patch installer delivers the targeted fixes to update the IBM TRIRIGA Application
Platform from version 3.3 to version 3.3.0.1. Do not use the 3.3.0.1 fix pack installer on versions of the
IBM TRIRIGA Application Platform before version 3.3. To upgrade to IBM TRIRIGA Application Platform
version 3.3, follow the instructions at the following link:
http://www.ibm.com/support/docview.wss?uid=swg24033723.
The version 3.3.0.1 fix pack installer patches the platform EAR (Enterprise ARchive) file and updates
any database tables that are used by IBM TRIRIGA Application Platform and that require modification. If
your application server is running JBoss or WebSphere, the EAR file is updated and redeployed. If your
application server is running WebLogic, the EAR file is patched and a manual redeployment is required.
To download the 3.3.0.1 fix pack, go to Fix Central at the following link:
http://www.ibm.com/support/fixcentral. In the Find Product tab, type TRIRIGA 3.3.0.1. Download
the readme.txt file and the patch installer appropriate for your operating system. Follow the
directions in the readme.txt file.
The changes to the IBM TRIRIGA Application Platform for this release include the following:
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Area of Change

Description

Application Server
Setup

The TRIRIGA Integration Object no longer imports every time you start the
application server against an Oracle database. (Tri-69516)

Custom Portals

Resolved an issue that caused parameters in a Custom Portal query string to
become invalid due to the addition of extra parameters. (Tri-71733)

IBM TRIRIGA CAD
Integrator/Publisher

Resolved an issue that caused a login to IBM TRIRIGA CAD
Integrator/Publisher version 12.0 to fail after an upgrade to IBM TRIRIGA
Application Platform version 3.3. (Tri-70140)

IBM TRIRIGA
Workplace
Reservation Manager

Resolved an issue that caused incorrect availability for a resource in the
following circumstances: The resource had 24-hour availability and the
event fell in a specific time range after the change to daylight saving time.
(Tri-69525)

Query and Reporting

Resolved an issue in which fields of type Date and Time did not filter
correctly at query run time if a time value was not included as part of the
filter value. Now, if a user does not input a time value, a time value of
00:00:00 is used. (Tri-70130-IV33185)

Web Graphics

Running associative graphic reports with hatch patterns in Graphics sections
or in IBM TRIRIGA CAD Integrator/Publisher now works properly when the
data does not include associated records for some groups. (Tri-69997)

IBM TRIRIGA Application Platform 3.3.0.1 Properties
Files
The properties files did not change with this release.

IBM TRIRIGA Application Platform 3.3 Enhancements
The enhancements to the IBM TRIRIGA Application Platform for this release include the following:
Area of Impact

Description

Platform-wide

Major enhancements to the platform include the following.
 Alternate form

 iCal notifications

 Alternate print form

 In memory smart object

 Availability widget

 In session option for Modify
Metadata workflow task

 Calendar server
 Calendar set builder
 Calendar widget
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Area of Impact

Description
 Conditional pop-up form on form
state transition
 Conditional query
 Contact role-based security
 Customizable pop-up form size
 Date/date time/duration widget
enhancements

 Microsoft Exchange power shell
script support to create Exchange
resources
 Microsoft Exchange Web Service
(EWS) workflows
 Microsoft Outlook add-in
 Relative date and time fields

 ETL enhancement to support
utilization calculations

 Reserve query

 Future trigger action in workflow

 Workflow formula functions

 Graphics section hover over, lock
theme, and new color to theme

 Workflow variable assignment
from expression

 SMTP agent

 Graphics section links to
Availability section
Globalization

Instance data can now be translated.

Administrator
Console

The system status now loads asynchronously. You can click the OK or warning
message to retest the status. (Tri-30859)

Currency

Enhanced the financial transaction posting process to use the most recent
currency conversion rate if one does not exist for the posting date and time
of the transaction. (Tri-37084)

Data Modeler

The base currency for a currency conversion can be set at run time to
replace the value of the BaseCurrency property in the
TRIRIGAWEB.properties file. If a Number field or a UOM field is defined
as having a UOM of Currency, and the Default UOM is SYSTEM_BASE, when a
user enters a value in that field, that value becomes the base currency for
the TRIRIGA system. Additionally, when SYSTEM_BASE is specified as the
UOM for a business object field, at run time, for that field, the current user's
profile record is not used to initially default the UOM value. (Tri-37001)

Graphics

A graphics section now can be linked to an availability section in the same
form. The graphic highlights all spaces that are available for reservation at a
given time based on the backing query of the availability section. The spaces
are highlighted in a different color than is used when a query section is
linked to a graphics section; this color is identified in the Selectable field of
the theme. A user can select the spaces either in the availability section or
in the graphics section. This feature applies to the availability section but
not to the availability legacy section. (Tri-36971)

Graphics

In a graphics section, the theme and its associated labels and report can be
locked to a default specified in either the section properties in the Form
Builder or in the theme list. When a user opens a form with the graphics
section, the values of Theme, Labels, Report, and the label type cannot be
changed. (Tri-36661)

© Copyright IBM Corporation 2011, 2013.

64

Area of Impact

Description

Graphics

Now you can show additional information for spaces in a graphics section in a
tooltip box while the user moves the mouse over the spaces. The content of
the tooltip is dynamic and relative to the space being hovered. The
appearance of the tooltip is based on a label style that is tied to a theme.
Additionally, when the theme has a hover label style defined, a button on
the graphics section allows the user to disable the tooltips. (Tri-36156)

License and Security

The IBM TRIRIGA Workplace Reservation Manager license now gives all users
the access granted by the license. You can limit what a user can do with
group security. (Tri-37064)

Metric Reports

Metric queries now use the database functionality for year and month for
values for group by Calendar Period Year and Calendar Period Month instead
of relying on the Calendar Period classifications. The display of year and
month is based on the user’s My Profile and is formatted as yyyy and yyyy
- MM - MMMMM respectively. (Tri-37185)

Query and Reporting

Added support for $$PARENT::[Section Name]$$ functionality in a query
field filter. Prior to this release, $$PARENT::[Section Name]$$ was only
supported in an association filter. (Tri-37072)

Query and Reporting

The new $$PERSONID$$ query field filter resolves to the record ID of the
triPeople record that is associated to the user that invoked the query. If
the current user is not associated to a person, an error is displayed.
Similar to $$USERID$$, it also supports section or field access. One
example of valid notation to resolve the first name of the current person is:
$$PERSONID::Detail::triFirstNameTX$$. (Tri-36949)

Workflow Builder

The Variable Definition task and the Variable Assignment task now allow the
variable value to be set from the result of an expression. The result of the
expression returns record IDs. For example, this can be used to find a set of
dates that match a recurrence pattern and that are within a date range.
After the record IDs for the dates are returned, the workflow can iterate
through them and perform other actions. (Tri-33133)

IBM TRIRIGA Application Platform 3.3 Changes
The changes to the IBM TRIRIGA Application Platform for this release include the following:
Area of Change

Description

Administrator
Console

A double-click when starting or stopping an agent does not leave it in an
invalid state. The second action is ignored. (Tri-37040)

Administrator
Console

In the Workflow Events manager, the field label for Oldest WF Event in
Queue has been changed from Event Type to User Account. (Tri-38292)
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Area of Change

Description

Administrator
Console

Resolved an issue that caused the Administrator Console to time out on
WebSphere regardless of user activity. (Tri-40494)

Administrator
Console

The Database Manager now shows the names of the objects and the types of
objects invalid in an Oracle schema. (Tri-35438)

Administrator
Console

The link to the WebLogic console from the Administrator Console now works
properly when the installation has a context path. (Tri-39639)

Agents

If the time on a server in a database cluster is off by more than a few
seconds, unpredictable results occur when operating the system. The IBM
TRIRIGA Administrator Console attempts to determine if a server in the
cluster is off by a few seconds. If so, the status message displays a warning
that a server's time may be off. After the times on the database servers have
been synchronized, you can select the status again to re-run the test.
(Tri-35482)

Agents

Resolved a Cleanup Agent issue that caused record data cleanup to fail if a
document parsing exception was encountered during the cleanup of images.
(Tri-38032)

Agents

The Extended Formula agent now continues to process entries after
encountering an entry with a spec_id less than 0 in the queue. (Tri-38513)

Applets

If applet-related properties in TRIRIGAWEB.properties are left blank,
then the applet attempts to find the latest version of Java on your system
and use that to run the applet. This affects applets related to Availability
Legacy sections, SVG Viewer, Document Manager, object uploads, Workflow
Builder (expression editor), and Stacking sections. (Tri-37219)

Application Server

The deployment into WebSphere has been automated in the installer. New
and upgraded installations are now set up automatically. (Tri-30497)

Application Server

The user that installs TRIRIGA must have write or create access to the
installation root directory. (Tri-37250)

Application Server

When a session expires, the user is now taken to the unauthorized page
($context_path$/unauthorized.jsp). That page includes the correct
HTTP error code for 508 compliance, plain text telling the user that they are
no longer authorized, and a link to the sign in page. (Tri-38425)

Calendar Tab

The weekly view is now shown in the format from the user's profile.
(Tri-36838)

Charting

Resolved a charting issue that caused certain grouped by day metric query
charts to show the same date multiple times along the date axis. (Tri-38481)

Charting

Resolved an issue involving charts in form sections where the title of a chart
displayed even when the Show Query Header property was not checked.
(Tri-37044)
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Area of Change

Description

Crystal Reports

Resolved an issue where Crystal reports created with ADO XML Version 1
were not correctly rendering data in report columns for business object field
names that contained spaces and were included in a smart section.
(Tri-36200)

Currency

A user is warned if they enter a conversion rate that has more than six digits
to the right of the decimal point. (Tri-39153)

Data Modeler

An empty module can now be deleted from the Data Modeler. (Tri-498)

Data Modeler

Improved the size of the Tools menu that a user sees after selecting a
business object in the Object Browser. (Tri-31744)

Data Modeler

Resolved an issue that caused business object field where used to not display
correct results for extended formula usage. (Tri-39449)

Data Modeler

Revising a business object enables the links on the State Transition tab.
(Tri-4964)

Data Modeler

The Association List in the Data Modeler now is sorted in alphabetical order.
(Tri-22035)

Data Modeler

The process of publishing business objects now creates indexes on certain sys
columns used in queries. For the indexes to be created, you need to
republish existing business objects. (Tri-35768)

Document
Management

Document permissions can now be optionally controlled by a Custom task and
workflow to apply permissions on a record by record basis. (Tri-39086)

Document Manager

Folder names are now sorted based on the user's locale. (Tri-40107)

Document Manager

Resolved an issue where not all files selected using the download icon were
listed in the MultiFile Download Files tab. (Tri-37021)

Financial Tokens

At workflow runtime, a workflow field map no longer maps a value from the
source record to the destination record when the target field has a formula
defined in its Business Object Field definition. The target field value is now
calculated and derived from its Data Modeler formula mapping. If a formula
field is grayed out on the Object Mapping form, it means that the formula
map defined in the Data Modeler is used as the source value for this field.
Note that a total field that adds up a sum field in a smart section is also
considered a formula field for the purposes of this behavior. To return to the
prior functionality in which workflow mapping is executed instead of
mapping defined in the Data Modeler, you must remove the formula mapping
defined for this field from the Data Modeler; then workflow mapping is
applied to the field. (Tri-36356, Tri-39564)

Form Builder

The default value for duration fields displays correctly when the user clicks
the Source Details link. (Tri-6487)

Form Builder

Two new properties in the root of a form can be used to indicate the size of
the form if it opens in a popup window. The properties are Popup Height and
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Description
Popup Width. These properties apply to forms that load from a query, the
add action on a query, a custom action on a query section, the Add action on
a query section, a chart, a portal section, an action on a portal section,
section actions, and field actions. (Tri-37245)

Form Builder

When a user tries to create a new default form with the same name as an
existing form, the Default Form check box is no longer selected and read
only. (Tri-4819)

Form Builder

When the user deletes a style sheet in the Style Manager, the deleted
properties no longer show in the properties panel. (Tri-21665)

Gantt

A form validation triggered when a user saved a record, when the form had a
smart section with a name different from the data section name and had an
unfilled required field, now finds the correct source record to validate.
(Tri-39467)

Gantt

Gantt calculations now consider daylight saving status on the task's
destination time zone. (Tri-37182)

Globalization

Resolved a metric query charting issue where Gauge chart types were not
correctly formatting numbers for the user's locale. (Tri-39200)

Globalization

Resolved a metric query charting issue where Pie and Pyramid chart types
were not correctly formatting numbers for the user's locale. (Tri-39799)

Globalization

The installer now creates a translations folder in the userfiles directory
to contain imported label translation files. (Tri-38627)

Globalization

To display multi-byte characters with the Adobe SVG Viewer, a user must
install the appropriate character-specific Adobe SVG viewer. (Tri-36402)

Globalization

Users now see a spinning wheel instead of "loading...". (Tri-36869)

Graphics

A Drawing Not Found error no longer occurs if a drawing that uses XRef
drawings is being viewed in a graphics section and a drawing that uses one or
more of the same XRef drawings is published. (Tri-37243)

IBM TRIRIGA
Connector for
Business Applications

Multiple users firing Query Continuation Token requests no longer cause
ConcurrentModificationExceptions. (Tri-37081)

Installer

The installer now collects values for the
BRAVA_INTERNAL_DOWNLOAD_HOST and
BRAVA_EXTERNAL_DOWNLOAD_HOST properties in the
TRIRIGAWEB.properties file during the install. You no longer need to
manually edit the TRIRIGAWEB.properties file to set these values.
(Tri-39158)

Label Manager

Resolved issues causing page messages, tab messages, and label tooltips to
be deleted when a value was entered for US English. (Tri-36709)
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Description

License and Security

An IBM TRIRIGA Capital Projects Manager license now includes
triProductsAndServices. With this change, users with Capital Projects
Manager licenses can create purchase orders containing products and
services. (Tri-37038)

License and Security

The IBM TRIRIGA Connector for ESRI Geographic Information System license
has been incorporated into each of the following applications and is no
longer available separately: IBM TRIRIGA Real Estate Manager, IBM TRIRIGA
Capital Projects Manager, IBM TRIRIGA Facilities Manager, IBM TRIRIGA
Workplace Operations Manager, IBM TRIRIGA Portfolio Data Manager, and IBM
TRIRIGA Facility Assessment. Users must have one of these licenses for ESRI
GIS to work as expected. The IBM TRIRIGA Connector for ESRI Geographic
Information System requires a license for the IBM TRIRIGA Connector for
Business Applications.
The IBM TRIRIGA Connector for Energy Star Benchmarking license has been
incorporated into the IBM TRIRIGA Real Estate Environmental Sustainability
Manager license and is no longer available separately. The IBM TRIRIGA
Connector for Energy Star Benchmarking requires a license for the IBM
TRIRIGA Connector for Business Applications. (Tri-40397, Tri-40398)

License and Security

User licenses and security settings are now checked before displaying
subreports in a query. (Tri-35319)

Lists

Clicking the Cancel action in the Label List window now only prompts the
user about losing unsaved changes if the user actually changed any of the list
values. (Tri-21920)

Metric Reports

Resolved a charting issue causing years to be displayed as decimal values.
(Tri-37916)

My Reports

Group By reports now show a Refresh icon for the user to refresh the query
results. (Tri-34564)

Navigation Builder

Group Override flag now remains intact between edit sessions of a navigation
collection. (Tri-37598)

Object Migration

Classifications with special characters can now be imported and exported
through object migration. (Tri-36035)

Object Migration

One or more spaces at the end of a classification name no longer prevent
successful object migration of the classification and its children. (Tri-36091)

Object Migration

Resolved an issue when importing or publishing with an object migration
package that includes the triDispositionMethod or
triDispositionType classifications. (Tri-34650)

Object Migration

Time field values on a record now import correctly into the target system.
(Tri-36589)

Object Migration

When performing an object migration, Tag fields in queries now move over.
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Description
(Tri-38263)

Portal

The links for Help and for Support open a new window and do not reset the
current portal. (Tri-37930)

Portal Builder

Added a new feature to report portal sections. Now if the value of Max
Records Displayed is set to 100 or more, at runtime that report section
renders a view that allows the user to do functions that could be done in a
full report view such as filter and export. (Tri-36913)

Portals

Resolved an issue where links were disabled on summary reports in portal
sections. (Tri-37075)

Projects

Project names now can contain special characters. Budget records in
projects with names containing special characters post properly. (Tri-33788)

Query and Reporting

A value with an E surrounded by numbers, for example, 1E15, exports from
a query into Excel in the correct format. (Tri-36330)

Query and Reporting

Cancel links no longer display on related reports within the portal.
(Tri-36054)

Query and Reporting

Grouping of records remains intact after every 5000 records in a report
exported to Excel. (Tri-36984)

Query and Reporting

If a business object is deleted from a module that has a query to find all
business objects in that module, the query now runs correctly. (Tri-37890)

Query and Reporting

Improved logging to help users identify issues with a report or query that
contains a problem with the metadata. The log entry contains the ReportId,
ReportName, UserId, and Referrer URL. (Tri-28579)

Query and Reporting

Resolved a charting issue that caused broken lines and missing bars to
sometimes occur after chart columns were sorted in alphabetical order.
(Tri-37257)

Query and Reporting

Resolved a metric query chart issue where month names were not being
translated to the language specified in the user's My Profile. (Tri-39310)

Query and Reporting

Resolved a Metric Query issue that caused Group By Date charts to not
render if the user's Date or DateTime format began with a stand-alone date
token. For example: d MMMM yyyy. (Tri-39073)

Query and Reporting

Resolved a query issue that caused more rows than expected to display when
multiple Group By columns were used in a report that had Sum columns.
(Tri-35619)

Query and Reporting

Resolved a query issue where system field filters that used the $$TODAY$$
special value caused corrupt SQL generation when used in conjunction with
filter grouping parentheses. (Tri-37033)

Query and Reporting

When the user selects a new value for a parent list in an editable query, the
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children values in the query are cleared. (Tri-32842)

Record Runtime

A record calendar now displays in the user’s preferred format. (Tri-36797)

Record Runtime

Functionality has changed when updating a UOM field value using a workflow
Modify Records task. Now the UOM value can be set using a name if that UOM
exists under the field's default UOM type or under the current field value's
UOM type. (Tri-37097)

Record Runtime

Multi-line text fields mapped into notifications no longer cause email clients
to display the raw HTML in the email message. (Tri-36680)

Record Runtime

Resolved an issue where certain locator fields that did not have the Locate
Using field name correctly set up on the business object were causing the
blue processing spinner to spin endlessly after the user entered text and
tabbed out of the field. (Tri-39491)

Record Runtime

White space is no longer added to new lines when saving records on multiline text areas. (Tri-37011)

Scheduling Engine

Monthly scheduled events with no end dates and using the first, second,
third, and fourth options no longer skip future months when regenerating
new events. (Tri-37749)

Style Manager

The Style Manager now displays RGB hex values for portal and other
components. (Tri-33132)

Style Manager

There were two sets of data and label styles in the system, in the Style Sheet
Editor and in the Style Manager. The Style Sheet Editor used the same field
styles as the Form Builder. The Style Manager now also uses these field
styles. (Tri-28391)

System Reports

Additional error handling that detects and manages “no module with id 0 can
be found” exceptions has been implemented for reports. (Tri-35414)

Tools >
Administration

Users now can translate name salutations such as Mr. and Mrs. (Tri-36796)

WebSphere

If using Java 1.7, set the following Java property on application server
startup to ensure the proper sorting behavior:
-Djava.util.Arrays.useLegacyMergeSort=true
See http://www.oracle.com/technetwork/java/javase/compatibility417013.html#source for more information. (Tri-40165)
If using IBM Java 1.7, the release version needs to be 7.0.0 SR1 at a
minimum. (Tri-39084)

Workflow Builder

A record with multiple User/Approval tasks in separate workflows no longer
auto-completes the second task. The system now waits for the user to
perform the action. (Tri-36945)
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Description

Workflow Builder

Adding a variable task and clicking the task to load its property no longer
causes a JavaScript error. (Tri-37074)

Workflow Builder

In workflow builder mapping, removed the option to map values to a formula
field. (Tri-37304)

Workflow Builder

Resolved an issue that prevented the Switch task from loading when a
previous task had an '&' in the task label. (Tri-37629)

Workflow Builder

There is a new function available in workflow that gets the UOM type of a
field, getUomType(recordId, fieldName). The first parameter can use
a system business object record ID field and the second parameter is a string
value. (Tri-37267)

Workflow Builder

When a module or business object changes in a Variable Definition task,
workflow parameters tied to that Variable Definition task are now updated
with the new module or business object. (Tri-38354)

IBM TRIRIGA Application Platform 3.3 Properties Files
This section describes changes to the TRIRIGAWEB.properties file. For more information, go to the
IBM TRIRIGA Application Platform 3 Information Center and select Installing IBM TRIRIGA Application
Platform > Configuring the platform > Properties files.
Area of Change

Description

ALLOW_ETL_DETERM
INE_DB_CONNECTIO
NS

Allows the Extract, Transform, and Load (ETL) processes to determine
whether or not to use multiple database connections. If set to Y, then the
value of Use Unique Connections on the ETL determines whether to use one
connection (On) or multiple connections (Off). Setting Use Unique
Connections to Off in the ETL can improve performance for long-running
ETLs, but can cause the Application Server to run out of database
connections for large ETLs with lots of steps accessing the database. In this
case, it might be necessary to increase the Application Server maximum
database connections. If set to N (legacy behavior), then the platform
automatically sets Use Unique Connections to On when running the ETL.
Therefore only one database connection is used by the ETL. The default
value is N. (Tri-37042)

ALLOWED_URL_FOR_
REDIRECT

The list of URLs or external sites to allow for redirect. The URLS are
separated by spaces. IBM TRIRIGA blocks redirections to URLs that are not
internal to IBM TRIRIGA. To allow a redirection to an external URL, enter
that URL in the list. For example: http://google.com (Tri-36883,
Tri-36884)

Applets

If applet-related properties in TRIRIGAWEB.properties are left blank,
then the applet attempts to find the latest version of Java on your system
and use that to run the applet. This affects applets related to Availability
Legacy sections, SVG Viewer (Association tab works fine), Document
Manager, object uploads, Workflow Builder (expression editor), and Stacking
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Description
sections. (Tri-37219)

AVAILABILITY_CAC
HE_LOAD_FACTOR

The decimal value used by the availability section applet to determine how
much data to cache. This value is multiplied by the visible time range unit
and indicates how much time in the past and future is cached.
For example, with a value of 1.5, if the visible time range is 1 week, then
the applet loads one and a half weeks in the past and in the future, and
caches the data.

AVAILABILITY_CAC
HE_LOAD_THRESHOL
D

The decimal value used by the availability section applet to determine how
much data that the user still has in cache before loading more data to cache.
This value is multiplied by the visible time range unit.
For example, with a value of 0.25, if the visible time range is 1 week and
the user is scrolling the applet in the future, then when user has a quarter of
a week left in the cache, the applet loads more data and caches the data.

EXCHANGE_DOMAIN

The IBM TRIRIGA domain for the Microsoft Exchange server. For example:
tririga.com

FRONT_END_SERVER

You access IBM TRIRIGA with the URL in the FRONT_END_SERVER property to
use BIRT and the Gantt. (Tri-37276)

PDF_EXPORT_GRAPH
IC_STROKE_WIDTH_
OVERRIDE

Overrides all stroke (line) widths when a graphics section is exported to PDF.
On some larger-scale drawings, the width of lines can appear to be very thick
when zoomed into the PDF at a high magnification. This property can be
used to resolve that issue by setting the stroke width to a very small
constant value such as 0.0000001. When the value is left blank, the
exported PDF uses the stroke width defined per line in the graphic, which is
derived from the line widths as published from CAD. The default value is
blank, no value specified. (Tri-35267)

ServerRoot

The path to the parent directory of the userfiles directory.

SMTP_CLIENT_TIME
OUT

The SMTP timeout in minutes. For example: 10

SMTP_KEEP_EMAIL

Determines whether to keep the email after SMTP processing by iCalendar. If
set to Y, then the system keeps the email after processing. Use Y only when
SMTP processing is being debugged. If set to N, then the system deletes the
email after processing. In a production system, the value should be N.

SMTP_PORT

The port that is used by the Reserve SMTP Agent for incoming SMTP traffic. If
the value is anything other than 25, then the administrator might need to
route the SMTP traffic to this port. This value is the port on which IBM
TRIRIGA listens for SMTP traffic. For example: 25

SVG_PLUGIN_DOWNL
OAD_URL

This property has been removed. The Adobe SVG Viewer plug-in is no longer
available from Adobe for download. (Tri-40547)

TRIRIGA_RESERVE_

The label that is displayed when a user connects the Microsoft Outlook client
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Description

OUTLOOK_TAB_LABE
L

to the IBM TRIRIGA application server. For multi-byte support, you must
Unicode-escape your values according to the Java specification. Example:
TRIRIGA Reserve

TRIRIGA_RESERVE_
SMTP_ROOT

The simple mail transfer protocol (SMTP) root directory that is created when
the Reserve SMTP Agent is started. If the directory already exists, the IBM
TRIRIGA process must have write access to the directory.
Example for Microsoft Windows:
c:\tririga\install\userfiles\smtp\in\
Example for UNIX: /tririga/install/userfiles/smtp/in/

TRIRIGA_RESERVE_
SUB_DOMAIN

The IBM TRIRIGA subdomain for the Microsoft Exchange server. This value
determines which emails are forwarded to IBM TRIRIGA. The resources that
are managed in IBM TRIRIGA must have a contact to forward to in this
subdomain. For example: reserve.tririga

USE_WF_BINARY_LO
AD

If set to Y, the system uses the binary load process. The Workflow Templates
are loaded from the stored binary version, if they cannot be found in the
Workflow Template cache. If set to N or no value, the Workflow Templates
are loaded by processing the workflow definition into the binary format. The
default value is Y.

WF_FUTURE_AGENT_
SLEEPTIME

The number of seconds the Workflow Future Agent waits before checking if
more items need to be processed. The default value is 5.

WF_INSTANCE_SAVE

Renamed the default value from NEVER to ERRORS_ONLY to better
represent that errors are saved. (Tri-39747)
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IBM TRIRIGA CAD Integrator/Publisher 12.0.1
This chapter details important information, known limitations, and changes for IBM TRIRIGA CAD
Integrator/Publisher.

Important Information
Important information concerning IBM TRIRIGA CAD Integrator/Publisher for this release includes the
following:
Area of Impact

Description

AutoCAD

If you are using AutoCAD 2012 64 bit, you must be on SP1 or higher.
(Tri-37066)

Hover Help

If the hover help you are reading closes before you can finish, move your
mouse away and then back to redisplay the hover help.

IBM TRIRIGA
Application Platform

When your environment is on IBM TRIRIGA Application Platform 3.3 or later,
to use IBM TRIRIGA CAD Integrator/Publisher, all CAD Integrator client
workstations must be on IBM TRIRIGA CAD Integrator/Publisher version 12.0
or later.
To use IBM TRIRIGA CAD Integrator/Publisher 12.0, you must be on IBM
TRIRIGA Application Platform 3.3.
To use IBM TRIRIGA CAD Integrator/Publisher 12.0.1, you must be on IBM
TRIRIGA Application Platform 3.3.1.

MicroStation

For MicroStation users of IBM TRIRIGA CAD Integrator/Publisher, the file
areapat.cel is required in order for fills to work properly. The installer
does not provide this file, and it is the responsibility of the user to provide
it. The areapat.cel is installed by default with MicroStation V8i (Select
Series 2), and IBM TRIRIGA CAD Integrator/Publisher attempts to load it.
However, if IBM TRIRIGA CAD Integrator/Publisher cannot locate the file or if
you are running a different version of MicroStation V8i, you need to copy the
areapat.cel file into the CAD Integrator installation directory. (Tri-35695)

Single Sign-On

If you are using SSO through IIS, you must have the Basic authentication
option selected in order for IBM TRIRIGA CAD Integrator/Publisher to sign in
properly. You can use any other combination of authentication options
(Basic, Digest, and Windows Integrated), provided that both Digest and
Windows Integrated are not selected at the same time. (Tri-21349)

Upgrade to version
12.0

The steps to upgrade from CAD Integrator 10.0 to IBM TRIRIGA CAD
Integrator/Publisher version 12.0 are described in the IBM TRIRIGA 10
information center. From the information center, select Integrating,
publishing, and reporting on CAD drawing information > Installing and
upgrading TRIRIGA CAD Integrator/Publisher.
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Area of Impact

Description
After the upgrade, you must redefine reporting information and application
definitions on the server side. For reporting (labels/fills/graphic reports),
each user of IBM TRIRIGA CAD Integrator/Publisher must recreate the
reporting that was defined on their client, on the server. Alternatively, users
can use the standard graphics for labels and reports. If you have heavily
customized your applications, you must adjust the standard application
definitions.

Known Limitations
Known limitations concerning IBM TRIRIGA CAD Integrator/Publisher for this release include the
following:
Area of Impact

Description

Data

IBM TRIRIGA CAD Integrator/Publisher for AutoCAD supports multi-byte
characters in drawings, windows, and records. IBM TRIRIGA CAD
Integrator/Publisher for MicroStation supports multi-byte characters in IBM
TRIRIGA CAD Integrator/Publisher windows and in IBM TRIRIGA records.

Installer

The installer is only available in US English. By default Install Anywhere
installs to a folder with the literal value Program Files. On non-English
versions of Microsoft Windows, this folder has a translated name and an
install to a folder named Program Files may not work. If you are
installing IBM TRIRIGA CAD Integrator/Publisher on a non-English version of
Windows, install to a folder with a different name. For example, C:\CI.

Publish

A graphics section does not render entities output to the DXF paper-space.
(Tri-32950)

IBM TRIRIGA CAD Integrator/Publisher 12.0.1
Changes
The major changes to IBM TRIRIGA CAD Integrator/Publisher for this release include the following:
Area of Change

Description

Attach

You can now attach and upload Circles, Ellipses, and Regions. Note that
publishing Regions to Web Graphics remains unsupported. (Tri-86286IV39579)

Attach Drawing

Attaching a drawing when the default CI theme has a report set, and display
legend is on, displays a legend for the query run on the entire system (e.g.,
the Space Class query shows every space in the system). Now the query is
not run if there are no attached entities on the drawing. (Tri-78863)
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Description

Batch Associate

In AutoCAD, if the user selects an unattached entity when running Batch
Associate, the dialog stays open and informs the user no attached entities
were selected. (Tri-69007)

Batch Associate

In Batch Associate, if a mapping that has no valid associated objects is
selected, an error message is displayed. Switching to a valid mapping now
clears the error message. (Tri-69258)

Batch Associate

In MicroStation, pre-selection can be used to filter the records listed in Batch
Associate form. (Tri-67178)

Batch Associate

Updated the error message that displays when no results are returned when
the user clicks the Find by Association action in the De-associate tab.
(Tri-88290)

Batch Edit

If the user selected an unattached entity when running Batch Edit, the dialog
stays open and informs the user no attached entities were selected.
(Tri-69006)

Batch Process

Batch Process function now attaches, uploads, and publishes design files
from MicroStation. (Tri-66128)

Batch Process

Batch Process was timing out when a Report was set in the default theme in
some environments. Now reports are not applied for Batch Process. Users
can still run sync at a later time to apply the report set on the default
theme. (Tri-76067)

Batch Process

Resolved an issue that caused batch process to time out when processing
large drawing. The timeout duration is now configurable in
ci.properties. (Tri-81581-IV39576)

Batch Process

The new OPEN_DRAWING_INTERNAL_TIMEOUT_SECONDS property in the
ci.properties file is the maximum amount of time in seconds to wait for
a drawing that is opened by internal IBM TRIRIGA processing, such as when
the Open Drawing From Record command is selected, or opened due to a
batch processing action. The default is 600 seconds (10 minutes). (Tri-89701,
Tri-90246)

Batch Process

You can now select more than one file at a time from the Add File window.
(Tri-76727)

Create Planning
Drawing

Added a message to indicate that the Create Plan drawing process is
complete. Also updated the log to indicate the specific cause when an
unexpected error occurs. (Tri-84268)

Create Planning
Drawing

Closing the original drawing after creating a new planned drawing no longer
results in an invalid menu configuration. This happened when the server was
on a Linux environment and was caused by drawing file path discrepancies.
(Tri-90228)
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Description

Create Planning
Drawing

Resolved an issue that caused sync failures at creation time for planning
drawings created from other drawings. This happened if the user's drawing
preference was set to Sync Drawing when Opened. Sync processing tied to
this preference is now disabled for planning drawings. With this change, a
user must start the sync manually after opening or creating planning
drawings. (Tri-87834)

Create Planning
Drawing

Resolved an issue that caused the Gross and Measured Gross boundaries on a
planning drawing to not be attached in MicroStation. (Tri-90361)

Create Planning
Drawing

Updated the create plan process to correct an issue that occurred on some
drawings with hatches applied that were upgraded from a previous version of
CI. The issue in create planning drawing resulted in the spaces in the create
plan drawing linking to the original space instead of to the planned space.
(Tri-85259)

Detach Drawing

Detach drawing now restores the layer colors of the Gross and Measured
Gross boundary on drawings attached using Smart Attach. (Tri-84243)

Detach Object

The Detach Object command no longer ends after detaching a single object.
It continues to be active until the user cancels it. (Tri-70760)

Find Object

In MicroStation, resolved the issue preventing the Find Object function from
finding employees or assets. (Tri-89724)

General

In version 12.0, CAD Integrator enabled the Attach Gross action and the
Attach Measured Gross action whenever a drawing was attached, regardless
of whether the gross or measured gross areas were actually attached. Now
the actions are enabled or disabled depending on whether gross or measured
gross areas are attached. In addition, using the Detach Object action on the
gross or measured gross areas correctly updates the menu. (Tri-77003IV37090)

General

Updated the location hierarchy tree to display a message that the translation
is not found instead of "null" if the record names returned are null. This can
happen if an environment is missing instance data translations for a user's
language. (Tri-90243)

General

Updated the message for "Sync Starting" to "Sync in progress..." in order to
reflect that the sync operation may take some time to complete. Similar
update for Smart Attach. (Tri-84260)

IBM TRIRIGA
Application Platform

Resolved an issue that caused a login to IBM TRIRIGA CAD
Integrator/Publisher version 12.0 to fail after an upgrade to IBM TRIRIGA
Application Platform version 3.3. (Tri-70702)

Insert Object

Moving an object block from one space to another in AutoCAD now deassociates the object from the first space and associates the object to the
second space. (Tri-67175)
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Description

Insert Object

Resolved an issue that caused block labels to not render after inserting
objects. (Tri-89217)

Installer

If version 12.0 is not present in the client computer before installing version
12.0.1, inches is selected as the value for drawing unit when the user has not
made any selection to the following dialogs: Smart Attach, Attach Drawing,
and Batch Process. (Tri-67170)

Installer

The shortcut icons are now created when the client computer has Java 7
update 21 or later installed. (Tri-89432)

Label Style

In AutoCAD, clearing a label style and applying a different label style now
renders the new label. (Tri-81784)

Login

If the portal project search system query does not contain triNameTX, the
user can sign in if the user has security to access the Company Level project.
If this occurs, a server error is logged. (Tri-88979-IV42155)

Login

Resolved a customer-specific data issue related to invalid UOM data. The CI
login process now logs an error on the server for this field if an invalid value
is encountered. (Tri-70153)

Menu

If no drawing is attached, the Sync Areas and Sync Full menu items are
disabled. (Tri-89426)

Menu

The Planning Drawing menu now includes Smart Attach and Attach Object in
order to support attaching and uploading Planned Spaces. (Tri-90221)

MicroStation

A select from design file option is now supported to select the Gross,
Measured Gross, Boundary, Name, and other layers directly from the design
file. You now can use the Smart Attach tool to upload spaces on a design file
after you select layers. (Tri-67177)

MicroStation

Batch Edit and Batch Associate now open the form if a legend is present in
the design file. (Tri-69005)

Publish

A publish now succeeds even if one of the XRef drawings is not found or has
an unresolved path. The unresolved XRef drawing is skipped during the
publish. (Tri-86846)

Publish

Resolved an issue that caused polylines to not show up in graphics sections
after publishing. The detach all objects command was not successful because
an attached entity had an empty original layer name before the drawing was
reattached and published. If you are experiencing this issue, you must run
the detach all objects command again before you republish. (Tri-81924IV38997)

Report

Attach Object was running the entire report/labels on all spaces every time
a single object was attached, which increased the run time. Now the fill and
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Description
label are only applied to the single object being attached to. Note that the
legend is not updated when attaching a single space; the user needs to apply
the report or sync first. (Tri-668333)

Report

In MicroStation, resolved an issue that caused the fill color on a server record
graphic report result to be rendered white whenever the color did not
exactly match the internal color table. Now the color rendered is the closest
RGB value in the MicroStation color table. Also, the internal color table now
uses the MicroStation color table, which makes it possible for users to render
custom colors by updating the MicroStation color table to match the RGB
value of the server record color. (Tri- 67179, Tri-85730)

Report

In MicroStation, the last row is now aligned correctly in a graphic report that
does not contain a row that aggregates fields, such as count or area.
(Tri-79394)

Report

Resolved an issue that caused an exception when a user applied fills via
attach/reporting when the number of entities in a drawing was an exact
multiple of 100. (Tri-70734)

Reporting

Clearing report and clearing label style now displays a message. (Tri-85587)

Reports

Applying a report now renders all spaces for a large (˜1000+) drawing.
(Tri-90244)

Reports

Graphic reports created by a user from the My Reports manager are now
available in the Report list of CAD Integrator. (Tri-69619)

Smart Attach

A text entity without a boundary no longer causes the processing of the
upload candidate to stop. Now, the error is logged and processing continues
for the other text entities. (Tri-84994)

Smart Attach

During upload candidate processing, the update count is no longer out of
sync with the actual records being updated. (Tri-80498)

Smart Attach

MicroStation now correctly detects subspaces when using Smart Attach or
Batch Process. (Tri-66123)

Smart Attach

The layer name selector fields on the Smart Attach dialog are now persisted
after a user exits the dialog. (Tri-87383)

Smart Attach

The OK button is now disabled on the Smart Attach form after the user clicks
it until the smart attach process is complete. (Tri-88099)

Smart Attach

The required field mapping default picker in the Smart Attach dialog shows
values even if one of the records does not contain a translated value. When a
translation is not available, the user sees the corresponding translation to
"The translated value is not available." message. (Tri-87386)
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Smart Attach

The Select from drawing option in the Layer drop-down selectors on the
Smart Attach form has been replaced by a Select from drawing button that
displays to the right of the Layer drop-down selectors. (Tri-87384)

Smart Attach

The View Errors button on the upload candidate dialog is disabled if there
are no errors. If there are errors, the button is enabled and the number of
errors is displayed on the button next to the label. (Tri-87385)

Smart Attach

Upload candidates no longer present additional invalid errors in the View
Errors dialog when a user selects a layer from a drawing for the mappable
field values. (Tri-87732)

Sync

Resolved a Full Sync issue that prevented all associated attached records
from being correctly synced in scenarios where a record had multiple
associated attachments. (Tri-89219)

Sync

The Sync Complete status message no longer displays before all processing
related to the Full Sync is complete. (Tri-81794)

Themes

The label of the theme is now displayed when the theme is applied.
(Tri-87555)

Tooltips

Resolved an issue where Smart Attach displayed tool tips designed for Batch
Process. (Tri-73153)

Upgrade

Resolved an issue with upgrade that caused the publish to fail on some old
drawings that contained non-multi-lined text labels. The command
TRGA_PurgeXData resolves this issue in drawings that have already been
upgraded. (Tri-81907-IV38981)

Upgrade

Updated the TRGA_PurgeXData command to remove bad drawing
attachment data caused by a missing application definition in an old
drawing. Updated the Upgrade processing of old drawings to automatically
call the TRGA_PurgeXData command if the upgrade process fails for any
reason. Added a ci.property, AUTO_PURGE_WHEN_UPGRADE_FAILS, to
enable users to turn off this automatic purge on failure behavior. (Tri-88997)

Upload Location

Smart Attach and Batch Process now display progress indicator messages on
the command line when uploading spaces (e.g., "Uploaded 50 of 134
records...") as the upload runs. (Tri-84142)

Web Graphics

Applying a graphic report to a drawing in web graphics that has an attached
region entity now renders the report correctly. (Tri-89213).
Note that published Regions in Web Graphics remains unsupported.

Web Graphics

Attached asset entities are now visible from the web graphics section.
(Tri-91833-IV43132)
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Description

Web Graphics

Resolved an issue that caused the as-delivered Charged To Organization
report to fail to run in either web graphics or IBM TRIRIGA CAD
Integrator/Publisher (Apply Report). The issue occurred because the Hatch
Field that was specified on the report definition did not have at least one
space with an associated Organization. In general, if a graphic report has an
associated object result that may not exist, for example no Organization
associated to a space, then this issue occurs. An alternate method is to
remove the Hatch Field from the report. (Tri-69901)

IBM TRIRIGA CAD Integrator/Publisher 12.0
Enhancements
The enhancements to the IBM TRIRIGA CAD Integrator/Publisher for this release include the following:
Area of Impact

Description

Globalization

IBM TRIRIGA CAD Integrator/Publisher is available in the following languages
supported by IBM TRIRIGA: Brazilian Portuguese, Chinese (Simplified and
Traditional), Czech, Dutch, French, German, Hungarian, Italian, Japanese,
Norwegian, Polish, Russian, Spanish, Swedish, and US English.
IBM TRIRIGA CAD Integrator/Publisher for AutoCAD supports multi-byte
characters in drawings, windows, and records. IBM TRIRIGA CAD
Integrator/Publisher for MicroStation supports multi-byte characters in IBM
TRIRIGA CAD Integrator/Publisher windows and in IBM TRIRIGA records.

Architecture

IBM TRIRIGA CAD Integrator/Publisher now uses a common Java framework.

Process
Improvements

The process flow has been improved to be more intuitive and streamlined.

Usability

The navigation in the menus and user interfaces has been improved. The
user interfaces include tooltips and intuitive labels that expose more
information at the level where the user is most likely to see it and where it
is most helpful. If necessary, users can click links to view more detailed
information. Improved and expanded system and program messages make it
easier for users to resolve problems on their own.

Application
Definitions

The application definitions are managed by an IBM TRIRIGA administrator and
are centralized in the IBM TRIRIGA environment.
A user can pull data from a CAD drawing to populate any IBM TRIRIGA field
that is specified in the application definition mappings.
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Description

Graphic Reports

Label styles, label filters, and graphic reports are centralized in the TRIRIGA
environment. IBM TRIRIGA CAD Integrator/Publisher users can reuse existing
web graphic reports, label styles, and label filters, or create their own
unique label styles, label filters, and CAD themes. A field in a graphic report
can be identified as a hatch pattern locator field. This field can then be used
to specify the hatch pattern, scale, and angle to be used when the report is
rendered in IBM TRIRIGA CAD Integrator/Publisher.

Smart Attach

CAD drawing information can be attached and published at one time, from
one interface with the Smart Attach feature.

Administration Tools

An IBM TRIRIGA administrator manages the product-wide configurations by
using the new CAD Integrator tools in the IBM TRIRIGA administration tools.
These configurations are available to all users that have appropriate security
group privileges.

IBM TRIRIGA CAD Integrator/Publisher 12.0 Changes
The major changes to IBM TRIRIGA CAD Integrator/Publisher for this release include the following:
Area of Change

Description

Administrator
Console

The new CadIntegrator thread setting in the Threads Manager controls the
number of threads the platform allocates to IBM TRIRIGA CAD
Integrator/Publisher when attaching a drawing. (Tri-37460)

Architecture

The architectural changes in IBM TRIRIGA CAD Integrator/Publisher 12.0
resolved or invalidated a large number of outstanding IBM TRIRIGA CAD
Integrator/Publisher issues from prior releases.
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IBM TRIRIGA Application Object Migration
Packages
IBM TRIRIGA delivers application object migration packages using two different methodologies:


Incremental Package: Each application release is a separate file named
TRIRIGA_<version>.zip. The latest incremental package is for IBM TRIRIGA 10.3.1.



Cumulative Package: The entire suite of IBM TRIRIGA applications in one file named
TRIRIGA_<version>_Cumulative.zip. Cumulative packages save substantial time when
you are upgrading across several releases. The latest cumulative package is for IBM TRIRIGA
10.1.



Note – To request access to IBM TRIRIGA software releases prior to IBM TRIRIGA 10.2 and
IBM TRIRIGA Application Platform 3.2, submit a ticket through the IBM Software Support
site at www.ibm.com/support.

Use the method that best meets your needs. Incremental package files might be best to upgrade across
one or two releases. The cumulative file might be best to update from an earlier version of the
application. Be aware, however, that the cumulative file is large and takes a long time to download,
load, and import. After you have the object migration package files downloaded, follow the steps in
this chapter to accomplish your application updates.

Applying the Application Object Migration Package



Attention – Before you perform an upgrade to IBM TRIRIGA 10.3, you must apply the SQL
script to update the system fields with sub-attribute type of CreatedDateTime to
CreatedDateTime (Number) and ModifiedDateTime to ModifiedDateTime
(Number). Scripts for Oracle and Microsoft SQL Server are located on the upgrade disk in
the \Scripts folder. Instructions are within the scripts.

The IBM TRIRIGA 10.3.1 release includes one incremental application package containing
enhancements, fixes, and corrections for the IBM TRIRIGA 10 applications, as described earlier.
If you are upgrading from IBM TRIRIGA 10.2.x, apply the SQL script to update the system fields. Then
use the 10.3, the 10.3.0.1, and the 10.3.1 incremental application packages.
If you are upgrading from IBM TRIRIGA 10.1, use the 10.2.0.1 and 10.2.0.2 incremental application
packages, apply the SQL script to update the system fields, and then use the 10.3, the 10.3.0.1, and
the 10.3.1 incremental application packages.
If you are upgrading from TRIRIGA 9, use the 10.1 cumulative package, the 10.2.0.1 and the 10.2.0.2
incremental packages, apply the SQL script to update the system fields, and then use the 10.3, the
10.3.0.1, and the 10.3.1 incremental application packages, as described in “Important Installation and
Upgrade Information”. Optionally, you can use incremental packages instead of the 10.1 cumulative
package and the 10.2.0.1, 10.2.0.1, 10.2.0.2, 10.3, 10.3.0.1, and 10.3.1 incremental packages. You
must proceed in this sequence:
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1. Upgrade to TRIRIGA Application Platform 2.7.2.3.
2. Load each incremental object migration package that is later than your current application
version, in order, up to and including 9.7.1. Depending on your current application version, you
may need to apply the 9.0.1, 9.0.2, 9.0.3, 9.0.4, 9.0.5, 9.0.6, 9.1, 9.1.1, 9.1.2, 9.1.3, 9.5.0,
9.5.1, 9.5.1Supp, 9.6.0, 9.6.0_Gantt, 9.6.1, 9.6.2, 9.7.0, and 9.7.1 packages. See the TRIRIGA
9.1 Release Notes for information about applying the 9.1 package. Perform each package
sequentially, in the order listed above. Wait until all of the steps below are complete for an
incremental object migration package before beginning the next.
3. Upgrade to IBM TRIRIGA Application Platform 3.3.1.
4. Load each incremental object migration package for 10.0, 10.1, 10.2.0.1, 10.2.0.1, 10.2.0.2,
apply the SQL script to update the system fields, and load each incremental object migration
package for 10.3, 10.3.0.1, and 10.3.1. Perform each package sequentially, in the order listed
above. Wait until all of the steps below are complete for an incremental object migration
package before beginning the next.
If you use the 10.1 cumulative package, you must also apply the 10.2.0.1 and 10.2.0.2 incremental
packages, apply the SQL script to update the system fields, then apply the 10.3 and the 10.3.0.1
incremental packages, and then apply the 10.3.1 incremental package.
Please read and follow “Importing Objects” in the IBM TRIRIGA Application Platform 3 Object
Migration User Guide for a description of how to import application packages. The following
summarizes a few Import features you may find helpful:

Summary
To see all warnings and errors found during validation, click the Summary action on the top of the
Object Migration screen. The Package Summary report appears.
The Object Summary at the top of the Package Summary report lists statistics for each object type, with
the warnings and errors hyperlinked to the corresponding summary section further down in the report.
The body of the Package Summary report contains a separate section for each object type with
warnings or errors or both. Within these sections, you can see the object name, module and business
object if appropriate for the object type, and the corresponding warning or error messages.

Comparison
Object Migration offers two comparison methods to find out more information about the differences
between uploaded items and existing items in the system. You can compare the entire upload with the
Comparison Report action or compare individual items with the Compare action in the Objects panel.
The comparison logic is the same for the Comparison Report and an individual Compare, with the main
difference being that one compiles the result into a file and the other displays the result in the user
interface.
Comparison Report
A Comparison Report compares every object in the uploaded package with objects in the target
system. The result is a tab-delimited .txt file. Each row in the Comparison Report represents one
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difference or conflict between the uploaded package and the target system. For example, if a business
object has 10 differences, there will be 10 lines in the Comparison Report, one for each.
Compare
The Compare action looks at just one object and compares what is in the uploaded package to what is
in the target system. To compare one of the objects in the upload with its counterpart in the target
system, select the object in the Navigation panel. The object displays in the Objects panel. Select an
item in the Objects panel and click Compare.

Logging
The import process in Object Migration generates informational messages when an object’s dependent
object names cannot be determined or verified. The message identifies the name of the object that
has an issue and lists its invalid references by type and where they were referenced. These messages
are sent to a log file named ObjectMigration.log. This file is located in the log directory of your
IBM TRIRIGA installation, for example at C:\TRIRIGA\log\ObjectMigration.log.
The ObjectMigration.log is configured in the log4j.xml file located in the config directory of
your IBM TRIRIGA installation, for example at C:\TRIRIGA\config\log4j.xml. Be sure to review
these settings and edit as desired before performing Object Migration.
It is very important to review the ObjectMigration.log after each Object Migration event.



Note – To help resolve any circular dependencies or references, the system automatically
imports the package two times. After each pass, the system refreshes the system cache.

Import Patch Helper Record
Whether you use the cumulative object migration package and the 10.2.0.1, 10.2.0.2, 10.3, 10.3.0.1,
and 10.3.1 incremental packages or a set of version-specific incremental object migration packages,
you must run the patch helpers for each application version between your current application version
and 10.3.1, including 10.3.1. Use the steps below to import the patch helper files for each version, in
version number sequence. The patch helper records update the Application Version record and trigger
workflows that update and create other essential information within the database.
Wait for one patch helper to complete before beginning the next. Some patch helpers may take a long
time to complete. After a patch helper completes, either clear all application server caches or restart
the application server.
How To Import the Patch Helper Record
Step 1

From the destination system, select Tools > Administration > Data Integrator.

Step 2

Select the following values in the Upload File section:
Module: triHelper
Business Object: triPatchHelper
Form: triPatchHelper
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How To Import the Patch Helper Record
Import Type: Add
Action: triCalculate
Step 3

Browse to identify the package to be imported.

Step 4

Click Upload File and click OK.

You will receive a notification in your Reminders portal section when the import process
completes.
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IBM TRIRIGA Supported Versions and IBM
TRIRIGA Application Platform Compatibility
Matrix
The IBM TRIRIGA Supported Versions lists information related to IBM TRIRIGA’s supported products and
platform and relays information about end-of-life plans for such software. The IBM TRIRIGA Application
Platform Compatibility Matrix lists supported operating systems, databases, and related details for and
about the IBM TRIRIGA Application Platform and relays information about end-of-life plans for such
software. The IBM TRIRIGA Supported Versions and the IBM TRIRIGA Application Platform Compatibility
Matrix may change over time. The IBM TRIRIGA Supported Versions and the IBM TRIRIGA Application
Platform Compatibility Matrix can be found on the IBM TRIRIGA wiki at
https://www.ibm.com/developerworks/community/wikis/home?lang=en#/wiki/IBM+TRIRIGA1/page/Su
pport+Matrix.

Related Documentation
You will find the documentation for this release in the IBM TRIRIGA 10 Information Center
http://pic.dhe.ibm.com/infocenter/tivihelp/v49r1/topic/com.ibm.tri.doc_10.3.1/welcome.html and
in the IBM TRIRIGA Application Platform 3 Information Center
http://pic.dhe.ibm.com/infocenter/tivihelp/v49r1/topic/com.ibm.tap.doc_3.3.1/welcome.html. The
documentation in the information centers can be found in online information center topics, or in PDF
files, or both.
This release introduces the following new documentation:


IBM TRIRIGA 10 Real Property Information Model Reference Manual (PDF), which can be found
at
https://www.ibm.com/developerworks/community/wikis/home?lang=en#/wiki/IBM+TRIRIGA1/
page/Real+Property+Information+Model



IBM TRIRIGA Application Platform 3 Upgrade Installation Guide (PDF), which can be found at
https://www.ibm.com/developerworks/community/wikis/home?lang=en#/wiki/IBM+TRIRIGA1/
page/Upgrading

This release includes updates to the following documentation:


“Installing IBM TRIRIGA Application Platform” (online topic) or IBM TRIRIGA Application
Platform 3 Installation and Implementation Guide (PDF)



“Integrating, publishing, and reporting on CAD drawing information” (online topic) or IBM
TRIRIGA CAD Integrator/Publisher User Guide (PDF)



“Managing leased and owned property contracts” (online topic) or IBM TRIRIGA 10 Lease and
Owned Property Contract Management User Guide (PDF)



“Managing portfolio data” (online topic) or IBM TRIRIGA 10 Portfolio Management User Guide
(PDF)



“Managing real estate environmental sustainability” (online topic) or IBM TRIRIGA 10 Real
Estate Environmental Sustainability User Guide” (PDF)
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“Managing reservations and reservable resources” (online topic) or IBM TRIRIGA 10 Reservation
Management User Guide (PDF)



“Requesting services” (online topic) or IBM TRIRIGA 10 Request Central User Guide (PDF)



“Strategic facility planning” (online topic) or IBM TRIRIGA 10 Strategic Facility Planning User
Guide (PDF)



“Web graphics in IBM TRIRIGA Application Platform graphics sections” (online topic) or IBM
TRIRIGA Application Platform 3 Graphics User Guide (PDF)



Application Building for the IBM TRIRIGA Application Platform 3 (PDF)



Application Building for the IBM TRIRIGA Application Platform 3: Data Management (PDF)



IBM TRIRIGA 10 Application Administration User Guide (PDF)



IBM TRIRIGA 10 Connector User Guide (PDF)



IBM TRIRIGA 10 Document Management User Guide (PDF)



IBM TRIRIGA 10 Facility Assessment User Guide (PDF)



IBM TRIRIGA 10 Getting Started User Guide (PDF)



IBM TRIRIGA 10 Maintenance and Service Management User Guide (PDF)



IBM TRIRIGA 10 Procurement Management User Guide (PDF)



IBM TRIRIGA 10 Program and Project Management User Guide (PDF)



IBM TRIRIGA 10 Space and Move Management User Guide (PDF)



IBM TRIRIGA Application Platform 3 Administrator Console User Guide (PDF)



IBM TRIRIGA Application Platform 3 Localization User Guide (PDF)



IBM TRIRIGA Application Platform 3 Reporting User Guide (PDF)



IBM TRIRIGA Application Platform 3 User Experience User Guide (PDF)



IBM TRIRIGA Connector for Business Applications 3 Technical Specification (PDF)

This release retires the following documentation:


IBM TRIRIGA 10 Report List

Support
IBM Software Support provides assistance with product defects, answering FAQs, and performing
rediscovery. View the IBM Software Support site at www.ibm.com/support.
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Notices
This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that only
that IBM product, program, or service may be used. Any functionally equivalent product, program, or
service that does not infringe any IBM intellectual property right may be used instead. However, it is the
user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.
IBM may have patents or pending patent applications covering subject matter described in this document.
The furnishing of this document does not grant you any license to these patents. You can send license
inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.
For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan
The following paragraph does not apply to the United Kingdom or any other country where such provisions
are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.
This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication. IBM
may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this one)
and (ii) the mutual use of the information which has been exchanged, should contact:
IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758
U.S.A.
Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.
The licensed program described in this document and all licensed material available for it are provided by
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any
equivalent agreement between us.
Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those
products.
All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.
This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an actual
business enterprise is entirely coincidental.

Privacy Policy Considerations
IBM Software products, including software as service solutions, (“Software Offerings”) may use cookies or
other technologies to collect product usage information, to help improve the end user experience, to
tailor interactions with the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings can help enable you to
collect personally identifiable information. If this Software Offering uses cookies to collect personally
identifiable information, specific information about this offering’s use of cookies is set forth below.
This Software Offering does not use cookies or other technologies to collect personally identifiable
information.
If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
notice and consent.
For more information about the use of various technologies, including cookies, for these purposes, see
IBM’s Privacy Policy at www.ibm.com/privacy and IBM's Online Privacy Statement at
www.ibm.com/privacy/details in the section entitled “Cookies, Web Beacons and Other Technologies” and
the "IBM Software Products and Software-as-a-Service Privacy Statement" at
www.ibm.com/software/info/product-privacy/.
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Trademarks
IBM, the IBM logo, ibm.com, and TRIRIGA are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide.
Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks
of Adobe Systems Incorporated in the United States, and/or other countries.
Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.
Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its
affiliates.
Other product and service names might be trademarks of IBM or other companies. A current list of IBM
trademarks is available on the Web at “Copyright and trademark information” at
www.ibm.com/legal/copytrade.shtml.
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